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Kata Pengantar

Puji syukur kepada Tuhan Yesus Kristus atas segala hikmat dan

kebaikan-Nya sehingga buku ajar ini dapat disusun dengan baik. Di tengah-

tengah kondisi pandemi COVID-19, buku tentang video editing ini disusun

dan merupakan bahan ajar dalam kelas ‘Teknik Penyuntingan Digital’.

Dunia penyuntingan (editing) video telah berkembang dengan sangat

pesat, terlebih jika melihat ke belakang. Percepatan teknologi dan era digital

menciptakan bermacam software untuk melakukan editing dengan baik.

Dalam buku ajar ini, penulis mencoba untuk menjawab tantangan dunia

industri dengan memperkenalkan 2 software yang sering digunakan dalam

dunia audio visual yakni Adobe Premiere Pro dan Adobe After Effect. Setiap

tahunnya, Adobe rajin mengeluarkan versi terbarunya dari 2 perangkat lunak

tersebut, namun untuk menjembatani gap, maka penulis memilih untuk

menyajikan dalam versi Creative Cloud 2015 untuk keduanya.

Buku ini disusun berdasarkan pengalaman penulis selama menggeluti

profesi sebagai editor dan visual effect specialist sejak tahun 2004 hingga

sekarang (2020, red). Banyak sisi praktis yang akan diulas dengan harapan

praktik yang dilakukan lebih efisien dan efektif. Di sisi lain, pengalaman

penulis dalam menjalani tes Adobe Certified Associate (ACA), diharapkan

mampu memberikan materi yang mendekati dengan problematika yang

ditemui apabila menjalani tahap yang sama di jenjang ACA.

Akhir kata, semoga buku ajar ini menjadi salah satu kado manis bagi

Prodi Ilmu Komunikasi yang ke 20 nantinya di bulan Mei 2020 dan juga

untuk Universitas Kristen Petra, almamater sekaligus tempat mengabdi, di

hari jadi yang ke-60. Buku ini tentunya tak lepas dari segala
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ketidaksempurnaan, oleh karenanya penulis mengharapkan masukan dan

saran untuk membuat buku ajar ini lebih baik. Namun penulis tetap berharap,

semoga buku ini memberikan insight dan pemahaman dalam bidang editing

video. Selamat menikmati.

Salam sehat,

Penulis
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BAB I

Mengenal Adobe Premiere Pro

Tujuan Pembelajaran Umum

 Mahasiswa mampu memahami Adobe Premiere Pro sebagai Non

Linear Editing Sistem dan memahami interfacenya.

Tujuan Pembelajaran Khusus

Pembelajaran pada bab ini bertujuan untuk:

 Mampu memahami proses produksi dalam pembuatan karya

audio visual.

 Mampu memahami keunggulan Premiere Pro sebagai sistem

editing non-linier.

 Mampu memahami Standar Alur Kerja Video Digital.

 Mampu memahami hal-hal yang harus diperhatikan dalam

pembuatan karya audio visual.

 Mampu memahami tampilan utama Adobe Premiere Pro.
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1.1. Proses Produksi dalam pembuatan karya audio visual

Dalam pembuatan sebuah konten audio visual (baik di televisi

maupun media soaial) tentunya melalui berbagai proses. Secara

umum terdapat 3 tahapan dalam proses pembuatan konten audio

visual, yaitu.

a) Pra Produksi

Pra produksi merupakan tahapan perencanaan dan detail

petunjuk pelaksanaan untuk tahap berikutnya yakni produksi

(Fachruddin, 2012). Selain itu, apabila diperlukan pembuatan

story board akan membantu tim produksi untuk memahami visi

dari konten audio visual yang akan diwujudkan. Tahap ini

menghabiskan 60-70% dari keseluruhan proses produksi.

b) Produksi

Tahap produksi merupakan tahap pewujudan rencana/ide

yang telah disusun sebelumnya. Dalam tahap ini, komunikasi

antar departemen menjadi kunci agar produksi dapat berjalan

dengan lancar dan sesuai dengan visi yang ingin dicapai.

Dalam tahap produksi juga banyak aspek teknis yang harus

dilakukan dan mengantisipasi segala hambatan yang terjadi

selama proses pengambilan gambar.

c) Paska Produksi

Pada tahap terakhir ini, merupakan tahap penyuntingan

gambar dan suara. Lebih detail, editing adalah proses

menyusun, memanipulasi, dan merangkai ulang rekaman video

menjadi suatu rangkaian cerita yang baru dengan memberikan

penambahan tulisan, gambar, atau suara sehingga mudah

dimengerti dan dapat dinikmati peserta (Fachruddin, 2012).

Dalam tahap ini, editor tidak hanya bekerja sendirian tetapi

juga akan disupervisi oleh Produser maupun Sutradara. Editor
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bertugas untuk menseleksi dan menyusun gambar sesuai

perencanaan awal. Di tahap inilah yang akan menjadi pokok

bahasan dalam buku ini.

1.2. Non Linear Editing pada Premiere Pro

Secara ringkas, proses editing ada 2 jenis yakni. Editing Linier dan

Editing Non-Linier.

a) Editing Linier

Editing Linier menggunakan sistem perekaman/ penyusunan

gambar yang berturutan (linear), jadi urutan gambar yang

diinginkan sesuai dengan urutan pada naskah. Proses editing

linier membutuhkan 2 alat untuk merangkai gambar, player

dan recorder. Editing linier di era digital semakin ditinggalkan

karena kebanyakan proses editing linier menggunakan kaset

dan masih analog. Berikut adalah perangkat yang digunakan

dalam editing linier.

Gambar 1.1. Diagram sederhana linier editing

Sumber: Teguh Depok

(https://teguhdepok.wordpress.com/editing-video/)

https://teguhdepok.wordpress.com/editing-video/
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Editor akan memilih klip yang akan digunakan pada player

dengan menekan tombol fast-forward dan rewind dengan

bantuan editing controller yang nantinya akan terhubung

dengan recorder player untuk merekam dan merangkai klip.

b) Editing Non-Linier

Editing Non-Linier adalah kebalikan dari editing linier. Proses

editing non-linier cenderung tidak berurutan. Editing jenis

kedua ini, memungkinkan untuk memindahkan, menghapus,

serta menduplikasi data-data. Dengan bantuan komputer dan

bermacam software editing video ini semakin popular

digunakan.

Gambar 1.2. Adobe Premiere Pro sebagai sistem editing non-linier

Sumber: Jago, 2018

Adobe Premiere pro merupakan sistem editing non-linier

(nonlinear editing system/NLE). Premiere Pro adalah software

untuk mengedit/menyunting/merangkai data (video, audio, still

image) sehingga menjadi sebuah video yang utuh.

Premiere Pro memungkinkan editor untuk meletakkan,

mengganti, bahkan menggerakkan footage di mana pun dan

kapanpun yang editor inginkan. Editor juga dapat

mengkombinasikan banyak klip untuk membuat sebuah sequence

yang dapat dimodifikasi dengan mudah, semudah klik dan
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menggeser dengan mouse komputer. Selain itu, Premiere Pro tidak

hanya mengkombinasikan klip tetapi juga dapat

mengkombinasikan beberapa sequence tanpa menekan bermacam

tombol seperti pada Editing Linier. Premiere Pro juga mendukung

media tape maupun dalam format digital.

Bermacam aktifitas editing yang dapat dilakukan dengan

Adobe Premiere Pro adalah memotong, memilih dan membuang

klip, melakukan pewarnaan, menstabilkan gambar yang bergoyang,

menambahkan gerakan-gerakan dasar, dan lain sebagainya.

Berbagai macam keunggulan ini yang menyebabkan Premiere Pro

menjadi salah satu software favorit yang banyak digunakan dalam

era digital.

Sebagai software kategori multimedia, Premiere Pro tidak bisa

lepas dan selalu berkaitan dengan software lain. Diperlukan

pengetahuan Adobe Photoshop untuk editing gambar, After

Effects untuk membuat animasi dan menambah kesan khusus pada

video, Audition untuk mengedit/menyunting audio, dan

sebagainya. Namun buku ajar ini berfokus pada Premiere Pro saja,

khususnya seri CC 2015.

1.3. Hal-Hal yang perlu diperhatikan sebelum melakukan Proses

Produksi Video

Dockery (2016) mengemukakan, dalam tahap pra produksi, ada

beberapa hal yang perlu diperhatikan, diantaranya:

a) Tujuan pembuatan konten

Perlu memastikan tujuan dengan jelas diharapkan dari klien.

Tujuan yang jelas akan memberikan visi tentang tayangan

video yang akan diproduksi. Dengan tujuan yang jelas maka

akan mempermudah dalam perencanaan.
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b) Target audiens

Perlu memperhatikan target dari penonton yang akan dituju.

Berbagai tayangan perlu disesuaikan dengan target audien

supaya sesuai dengan ketentuan moral dan umur yang berlaku.

c) Luaran yang diharapkan

Di era digital, perlu memperhatikan akan luaran yang

diharapkan. Dimensi layar misalnya, harus sesuai dengan

meda yang akan digunakan. Tiap platform memiliki target

luaran yang berbeda, oleh karenanya perlu disesuaikan dengan

spesifiikasi medium yang kan digunakan. Aspek luaran yang

perlu diperhatikan misalnya durasi dari video, format media,

dan beberapa detail teknis dalam proses rendering nantinya.

d) Aspek legal

Di era digital sekarang, selain memperhatikan dan menyusun

klip yang akan digunakan nantinya dalam tahap paska

produksi, seorang video editor juga perlu memperhatikan

aspek legal. Beberapa platform akan melakukan blokir

otomatis untuk menghindari penggunaan karya secara ilegal,

sebagai contoh adalah musik. Memperhatikan legalitas

penggunaan klip maupun music dalam konten audio visual

perlu menjadi perhatian supaya tidak terjadi hal-hal yang tidak

diinginkan di kemudian hari. Selalu perhatikan detail, ketika

akan mengunduh bahkan menggunakan karya audio visual

selain dari hasil perekaman sendiri.

1.4. Standar Alur Kerja Video Digital

Berikut adalah tahapan dalam alur kerja video digital:

a) Mengumpulkan footage. Dalam tahap pertama ini kita akan

mengumpulkan berbagai klip yang akan kita olah nantinya.
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Klip dapat diperoleh dari proses perekaman sendiri maupun

mendapatkan nya dari sumber lain dengan memperhatikan

aspek legal.

b) Menyimpan video (atau mengcapture dari kaset) ke hard disk.

Premiere Pro dapat merubah kaset menjadii format digital

dengan bantuan beberapa perangkat yang dibutuhkan.

Sementara dengan format digital, Premiere Pro dapat langsung

membaca file secara langsung dan dipindahkan ke hard disk

komputer. Jangan lupa untuk melakukan back up file.

c) Mengatur bermacam klip. Dalam memproduksi konten audio

visual tentunya akan memiliki banyak pilihan. Sisihkan waktu

untuk mengatur klip yang akan digunakan dalam folder

tertentu. Bahkan pengaturan klip dalam Premiere Pro dapat

dilakukan dalam folder ‘Bin” yang dapat diberi tanda dengan

warna yang berbeda.

d) Menggabungkan bagian-bagian klip video dan audio sebagai

sequence dan memasukannya ke panel Timeline.

e) Menambahkan efek transisi khusus antara klip, menambahkan

efek video, dan membuat efek visual gabungan dengan

menempatkan klip di beberapa lapisan (track).

f) Membuat judul atau grafis dan menambahkannya dalam

sequence.

g) Mengatur, memberikan transisi serta efek pada audio untuk

meningkatkan kualitas audio.

h) Export klip yang telah diedit menjadi luaran yang sesuai

dengan tujuan awal video direncanakan.
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1.5. Mengenal Elemen dasar pada interface Premiere Pro

Tampilan pada Premiere Pro pada dasarnya dapat diatur dengan

mudah. Misalnya untuk mengubah tampilan menjadi terang dengan klik

menu Edit > Preference. Tab Appearence. Lalu drag slider ke kanan.

Jika sering mengubah ukuran posisi panel, ada panel yang hilang, dan

sebagainya akibat pengaturan manual sebaiknya atur ke tampilan awal

dengan klik menuWindow > Workspace > Reset Current Workspace.

Secara detail, berikut adalah tampilan utama dalam Adobe Premiere Pro.

Gambar Gambar 1.3. Tampilan utama adobe Premier Pro

Sumber: Jago, 2016

Panel Timeline: Di sinilah editor akan melakukan sebagian besar

pengeditan. Anda melihat dan mengerjakan urutan di panel Timeline.

Salah satu kekuatan sequence adalah editor dapat langsung

menumpuknya. Cara ini akan memudahkan editor karena dapat memecah
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produksi menjadi beberapa bagian yang dapat diatur atau membuat efek

khusus yang unik.

Panel monitor: Terdiri dari 2 monitor yaitu Source Monitor dan

Program Monitor. Source Monitor (di sebelah kiri) untuk melihat dan

memilih bagian klip asli. Untuk melihat klip di Source Monitor, klik kiri

dua kali di panel Project. Program Monitor (di sebelah kanan) adalah

untuk melihat klip yang diedit pada panel timeline.

Panel project: Di sinilah aset akan dimasukkan. Aset dapat berupa klip

video, file audio, grafik, gambar, dan urutan. Editor dapat mengatur

semua media Anda menggunakan ‘bins’. Bins mirip dengan folder -

Anda dapat menempatkan satu bin di dalam bin lain untuk

pengorganisasian aset yang lebih advance.

Media Browser: Panel ini memungkinkan Anda untuk menelusuri hard

drive Anda untuk menemukan footage.

Library: Panel ini memberikan akses ke file yang telah ditambahkan ke

folder Creative Cloud Files di drive penyimpanan. Dapat berupa elemen

grafik standar, musik, atau file media lain yang ingin digunakan untuk

proyek.

Effect panel: Panel ini berisi efek klip yang akan digunakan dalam

sequence, termasuk filter video, efek audio, dan transisi. Efek

dikelompokkan berdasarkan jenisnya agar lebih mudah ditemukan, dan

terdapat search box di bagian atas panel untuk menemukan efek dengan

cepat.
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Gambar 1.4. Panel Effect yang memberikan pilihan efek dan transisi

pada audio dan video

Sumber: Jago, 2016

Audio Clip Mixer: Panel ini didasarkan pada perangkat keras studio

produksi audio, dengan penggeser volume dan tombol panning. Ada satu

set kontrol untuk setiap trek audio di Timeline. Penyesuaian yang

dilakukan akan diterapkan pada klip audio. Ada juga Audio Track Mixer

khusus untuk menerapkan penyesuaian audio ke track.

Panel Effect Control: Panel ini menampilkan kontrol untuk efek yang

diterapkan ke klip yang dipilih secara berurutan. Gerakan, transparansi,

dan pengaturan durasi tersedia untuk klip visual (video). Sebagian besar

parameter efek dapat disesuaikan sesuai keinginan.

Panel Tools: Setiap ikon di panel ini mewakili alat yang melakukan

fungsi tertentu, digunakan pada sequence yang ada di panel timeline.
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Gambar 1.5. Tanpilan panel tools yang menyediakan berbagai alat untuk

memotong dan memangkas (cutting and trimming)

Sumber: Jago, 2016.

Panel Info: Panel Info menyajikan informasi tentang aset apa pun yang

Anda pilih di panel project atau klip atau transisi yang digunakan.

Panel riwayat: Panel ini melacak langkah yang diambil dan

memungkinkan Anda membuat backup dengan mudah. Saat Anda

memilih langkah sebelumnya, semua langkah yang muncul setelahnya

juga dibatalkan. Short cut yang digunakan adalah ctrl+Z atau

command+z pada Mac.
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1.6. Latihan soal dan jawaban

Soal

1. Mengapa Adobe Premiere Pro disebut sebagai sistem editing

non-linear?

2. Sebutkan dan jelaskan proses produksi dalam pembuatan karya

audio visual!

3. Apa saja yang harus diperhatikan dalam pembuatan karya audio

visual.

4. Sebutkan Standar Alur Kerja Video Digital.

5. Jelaskan fungsi dari source monitor dan program monitor.

Jawaban

1. Adobe Premiere Pro disebut sebagai sistem editing non-linear

karena dapat memindahkan video, audio, maupun grafis

dimanapun pada panel timeline

2. Proses produksi terdiri dari 3 tahap yakni pra produksi (tahap

perencanaan), produksi (tahap pelaksanaan), dan paska produksi

(tahap penyuntingan)

3. Tujuan pembuatan konten, target audiens, luaran yang

diharapkan dan Aspek legal.

4. Mengumpulkan footage, Menyimpan video (atau mengcapture

dari kaset) ke hard disk, Mengatur bermacam klip,

Menggabungkan klip video dan audio sebagai sequence dan

memasukannya ke panel Timeline, menambahkan efek transisi

khusus antara klip, menambahkan efek pada video dan grafis,

membuat judul atau grafis dan menambahkannya dalam

sequence, Memberikan transisi serta efek pada audio untuk

meningkatkan kualitas audio, Export klip yang telah diedit
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menjadi luaran yang sesuai dengan tujuan awal video

direncanakan.

5. Source monitor digunakan untuk melihat klip original yang telah

diimport sementara program monitor digunakan untuk melihat

klip yang diedit pada sequence di panel timeline.
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BAB II

Mengenal Adobe Premiere Pro

Tujuan Pembelajaran Umum

 Mahasiswa mampu memahami tahap awal pembuatan project pada

Premiere Pro.

Tujuan Pembelajaran Khusus

Pembelajaran pada bab ini bertujuan untuk:

 Mampu membuat setting project dengan benar pada premiere pro.

 Mampu memahami beberapa fitur pada setting awall project.

 Mampu melakukan import klip.

Dalam bab ini, Anda akan mempelajari cara membuat project baru

dan memilih sequence setting. Anda juga akan mempelajari tentang berbagai

jenis trek audio, file preview, dan cara membuka project yang dibuat di Apple

Final Cut Pro dan Avid Media Composer.
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2.1. Setting Project

Ketika Adobe Premiere Pro CC 2015 diaktifkan maka akan muncul

dialog box sebagai berikut:

Gambar 2.1. Tampilan awal Adobe Premiere Pro CC 2015

Berikut beberapa penjelasan terkait tampilan awal di atas:

New Project: Klik menu ini untuk membuka kotak dialog project baru.

Open Project: Klik tautan ini untuk menelusuri file proyek Premiere Pro

yang ada dan membukanya untuk melanjutkan pengerjaannya.

Sync Setting: Klik tautan ini untuk sinkronisasi preferensi pengguna Anda

dengan yang Anda simpan di Creative Cloud. Ini memudahkan perpindahan

dari satu sistem pengeditan ke sistem lainnya.

Manage Account (pojok kanan atas): Klik icon ini untuk memilih ID Adobe

mana yang ingin Anda gunakan untuk menyinkronkan preferensi pengguna.

Help and support (icon question mark): Klik tautan ini untuk membuka

sistem bantuan online. Koneksi internet diperlukan untuk mengakses Bantuan

Adobe Premiere Pro secara online.
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 Klik New Project untuk memulai pengaturan awal Premiere Pro.

Gambar 2.2. Tampilan halaman kedua Adobe Premiere Pro

Tambahkan nama project pada kolom ‘name’.

Kemudian klik ‘browse’ pada kolom Location untuk menentukan lokasi

penyimpanan file.
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Pengaturan video rendering dan playback

Pada kolom video rendering dan playback, apabila dilihat akan terdapat 2

pilihan:

Mercury Playback Engine GPU Acceleration: Jika anda memilih opsi ini,

maka Premiere Pro akan mengirim tugas pemutaran ke grafis komputer yang

akan memberikan efek secara real-time dan playback yang mudah serta cepat.

Mercury Playback Engine Software Only: Opsi ini dapat dipilih jika komputer

yang anda gunakan tidak memiliki grafis yang cukup kuat.

Kedua pilihan tersebut dapat disesuaikan dengan kemampuan komputer yang

dimiliki.

Setelah menentukan nama project, lokasi penyimpanan, dan video rendering

maka tekan ‘ok’ untuk melanjutkan. Setting yang lain dapat dibiarkan default.

 Memulai editing pada sequence yang akan muncul di Panel Timeline

Gambar 2.3. Tampilan untuk membuat sequence baru.
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Apabila tampilan interface telah muncul, ikuti langkah berikut untuk membuat

sequence baru.

Klik File > New > Sequence (atau dengan short cut ctrl+N)

Sequence adalah rangkaian klip yang diputar satu demi satu dengan beberapa

layer yang diberikan efek khusus, judul, dan audio sehingga membuat

keseluruhan film yang lengkap (Jago, 2016). Secara ringkas, sequence dalam

Premiere Pro terdiri dari urutan klip yang disusun dan diberikan efek maupun

transisi tertentu sehingga menjadi satu kesatuan film yang utuh. Sequence

inilah yang dikerjakan pada Panel Timeline.

Kemudian akan muncul tampilan sebagai berikut:

Gambar 2.4. Dialog box untuk setting sequence

Pada tampilan ini, Premiere Pro akan memberikan pilihan setting kita

kerjakan sesuai dengan kamera yang kita gunakan. Segitiga di bagian kiri
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akan memberikan pilihan detail untuk jenis-jenis kamera yang kita gunakan

sehingga memperoleh dimensi ukuran layar yang sama. Untuk pengaturan

default maka DV-PAL dapat dipilih menjadi sequence nantinya. Tinggal

menyesuaikan ukuran layar yang akan kita gunakan. Terdapat 2 pilihan

Standart (4:3) dan Widescreen (16:9). Biasa yang digunakan adalah pilihan

Widescreen dan diplih yang 48 kHz.

Untuk pemilihan lebih detail, dapat memilih tab ‘setting’ di samping

tab ‘sequence setting’. Namun detail tersebut dapat diabaikan dan memilih

untuk default setting dari Premiere Pro. Pergantian format audio dan video

dapat dilihat lebih detail pada gambar 2.5. di bawah ini.

Gambar 2.5. Tampilan tab setting pada pembuatan sequence baru.

Pada proses pembuatan sequence baru ini, dapat juga diatur untuk

penggunakan layer atau track dalam istilah Premiere Pro. Secara default,
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Premiere Pro akan memberikan masing-masing 3 track untuk video dan audio.

Pengaturan audio master tidak dapat diubah namun jumlah track baik audio

maupun video bisa ditambahkan ataupun dikurangi. Berikut adalah detail tab

‘tracks’ di gambar 2.6.:

Gambar 2.6. Tampilan tab ‘Tracks’ pada pembuatan sequence baru.

2.2. Melakukan Importing Media

Untuk mengimpor aset (video dan file lain) dapat dilakukan dengan

memilih:

File > Import (atau menggunakan short cut ctrl+i) dengan tampilan sebagai

berikut:
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Gambar 2.7. Pilihan dalam menu file untuk melakukan import aset

Apabila aset sudah dipilih dan ditekan ‘ok’ maka aset akan terimport pada

panel Project dan untuk melihat tampilan aset ‘klik kiri 2 kali’ akan muncul

pada source monitor.

2.3. Tips dalam Pengaturan Project di Premiere Pro

Dalam melakukan pengaturan awal, ada beberapa tips yang dapat

dimanfaatkan:

a) Pada tahap awal pembuatan project, pastikan menyimpan semua file

dalam beberapa folder namun berada di lokasi yang sama.

b) Pastikan file yang diimport sesuai dengan format yang sesuai dengan

ketentuan Premiere Pro.

c) Cara cepat untuk mengimport aset, double klik pada area kosong yang

ada di Panel Project

d) Beberapa file yang dapat diimport pada Premiere Pro

diantaranya .psd, .jpg, .mp4, .avi, .mp3, dan sebagainya.
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Gambar 2.8. Berbagai piliihan file yang dapat diimpor pada Premiere

Pro.

e) Dalam pengaturan sequence perlu diperhatikan detail aset yang

dimiliki supaya sinkron dengan pengerjaan di panel Timeline

nantinya.
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2.4. Latihan soal dan jawaban

Soal

1. Apa tujuan dari tab Settings di kotak dialog New Sequence?

2. Bagaimana membuat sequence baru?

3. Bagaimana memilih preset sequence?

4. Berapa track yang disediakan secara default oleh Premiere Pro pada saat

akan membuat sequence baru?

5. Bagaimana cara melakukan import pada panel project?

Jawaban

1. Tab Pengaturan digunakan untuk menyesuaikan preset yang ada atau untuk

membuat preset baru sesuai keinginan.

2. Memilih menu File > New Sequence atau dengan shortcut Ctrl+N

(windows) atau Command+N (Mac OS).

3. Pengaturan yang baik adalah yang cocok dengan rekaman asli. Premiere

Pro mempermudah ini dengan menjelaskan preset dalam hal sistem kamera.

4. Masing-masing 3 track untuk audio dan video.

5. Pilih menu File > Import atau dengan double klik pada ruang kosong di

panel project
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BAB III

Dasar Penyuntingan

Tujuan Pembelajaran Umum

 Mampu memahami dasar penyuntingan pada Adobe Premiere Pro.

Tujuan Pembelajaran Khusus

 Mampu bekerja dengan sequence pada panel timeline

 Mampu menciptakan potongan kasar (rough cut) dengan

menggunakan fitur pada source monitor

 Mampu memahami tools pada Premiere Pro

 Mampu memahami cara bekerja dengan audio pada Premiere Pro
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3.1. Bekerja dengan sequence

Sequence dalam Premiere Pro adalah timeline dengan project di

dalamnya. Sequence tidak sama dengan project karena dalam sebuah project

bisa terdapat beberapa sequence. Dalam alur kerja sequence pertama adalah

mengambil klip dar source monitor atau bin, kemudian menambahkannya

dalam sequence yang ada pada timeline kemudian editing akan dilakukan.

Saat memuat sequence baru, hal yang perlu dipastikan adalah spesifikasi

sequence — seperti frame rate, aspek rasio (ukuran layar), dan rasio aspek

piksel — sudah sesuai dengan hasil akhir yang diharapkan. Namun tidak

selalu harus sama antara setting awal dengan setting hasil akhir video, karena

ketika akan export media (lihat bab 7) dapat dilakukan pengaturan kembali

akan hasil akhir yang diharapkan.

Beberapa cara yang dapat digunakan untuk menciptakan sequence baru

pada timeline diantaranya:

 Pilih klip yang ada di panel project, kemudian pilih menu File > New

> Sequence from Clip.

 Drag klip pada tombol New Sequence pada panel project atau bin.

 Apabila panel timeline masih kosong, drag dan drop klip dari panel

project atau bin ke panel timeline (gambar 3.1.).

 Klik kanan (Windows) atau Control-click (Mac OS) sebuah klip di

panel project dan pilh menu ‘New Sequence from Clip’.
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Gambar 3.1. Drag and drop sebuah klip langsung pada timeline untuk

membuat sequence baru.

Sumber: Dockery

3.2. Menciptakan potongan kasar (rough cut)

Untuk membuat potongan kasar dapat menggunakan fitur yang terdapat

pada source monitor. Berikut adalah fungsi dari beberapa tombol yang ada

pada source monitor.

Penggunaan Kontrol Source Monitor

Selain kontrol pemutaran, ada beberapa tombol tambahan penting di Source

Monitor.

Gambar 3.2. Keterangan tombol pada source monitor

Sumber: Jago

Add Marker: Menambahkan marker (penanda) ke klip di lokasi pemutaran.

Marker dapat memberikan referensi visual sederhana atau menyimpan

komentar.

Mark In: Memberikan tanda dimulainya klip yang diseleksi.

Mark Out: Memberikan tanda diakhir klip yang diseleksi.

Go to In: Pemindahan titik pemutaran ke titik mark in.
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Go to Out: Pemindahan titik pemutaran ke titik mark out.

Insert: Menyisipkan video yang ada pada source monitor pada urutan video

yang ada pada timeline.

Overwrite: Menimpa video yang ada pada source monitor pada urutan video

yang ada pada timeline.

Setelah memahami tombol pada source monitor, berikut adalah

langkah singkat untuk membuat potongan kasar (rough cut):

1. Pastikan sequence yang akan dikerjakan terbuka, sehingga terlihat di

panel Timeline.

2. Di panel Project, klik dua kali klip yang diinginkan. Maka klip

tersebut akan terbuka di Source Monitor.

3. Gunakan kontrol pada Source Monitor untuk menemukan di titik awal

klip harus dimulai.

4. Klik ikon Mark In, atau tekan tombol I pada keyboard.

5. Gunakan kontrol Source Monitor untuk menemukan titik akhir klip

harus berhenti.

6. Klik ikon Mark Out, atau tekan tombol O pada keyboard.

7. Pada panel Timeline, pastikan playhead (garis berwarna biru) berada

pada waktu di mana Anda ingin menambahkan klip yang terbuka di

Source Monitor.

8. Lakukan salah satu dari yang berikut:

 Untuk menambahkan klip di playhead sehingga durasinya

bergerak mengikuti klip nanti pada waktunya, klik tombol Insert.

 Untuk menambahkan klip di playhead agar menggantikan klip

yang menempati durasinya, klik tombol Overwrite.
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9. Kembali ke langkah 2 untuk menambahkan klip lain, dan ulangi

langkah 3–8 hingga semua klip yang diinginkan ditambahkan ke

dalam sequence pada panel timeline.

Memahami Pengaturan Gerakan (Motion) pada sub panel effect controls

Dalam beberapa kasus, diperlukan adanya pergerakan untuk

menyempurnakan tampilan yang ada di program monitor. Melalui kontrol

yang disebut Gerakan (Motion) pada subpanel effect controls, disana tidak ada

pergerakan hingga ditambahkan. Secara default, klip akan ditampilkan 100%

di tengah dari Program Monitor.

Gambar 3.3. Tampilan sub panel motion pada effect controls

Sumber: Jago

Berikut penjelasan beberapa opsi yang ada:

Position: merupakan posisi klip sepanjang sumbu x dan y. Opsi posisi default

untuk klip 1280x720 adalah 640, 360; yaitu, itu tepat di tengah.

Scale (Scale Height, when Uniform Scale is deselected): Klip disetel untuk

ukuran penuh secara default (100%). Untuk memperkecil klip, kurangi

angkanya. Juga bisa diskalakan hingga 10,000%, tetapi akan membuat gambar

menjadi pecah.
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Rotation: Menu yang digunakan untuk memutar gambar pada program

monitor.

Anchor Point: Pengaturan posisi dan rotasi berdasarkan pada Anchor Point,

yang secara default berada di tengah klip. Poros putaran bisa diubah kebagian

manapun, termasuk salah satu sudut klip atau bahkan bagian luar klip.

Misalnya jika Anchor Point diubah ke sudut klip, maka pengaturan rotasi klip

akan berputar disekitar sudut daripada di sekitar tengah gambar. Jika Anchor

Point diubah kaitannya ke gambar, maka klip harus diposisikan ulang pada

frame untuk mengimbangi penyesuaian.

Anti-flicker Filter: Fitur ini berguna untuk klip video yang saling bertautan

dan untuk gambar yang berisi detail tinggi, seperti garis halus, tepi tajam, atau

garis paralel (yang dapat menyebabkan masalah moiré).

3.3. Memahami tools pada Premiere Pro

Setelah berhasil membuat potongan kasar, maka editing dapat dilakukan

pada tahap lebih lanjut. Oleh karena nya, dibutuhkan pemahaman tentang

tools yang tersedia pada Premiere Pro. Berikut tampilan panel tools pada

Premiere Pro:

Gambar 3.4. Tampilan tools yang ada panel tools

Sumber: Jago
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Berikut adalah penjelasan tiap tools dimulai dari bagian yang paling atas:

Selection Tools: Tool default/ alat default, digunakan untuk alat memilih dan

menggeser clip pada timeline. Untuk menyeleksi beberapa klip gunakan Shift

+ Klik. Untuk menggesernya drag saja salah satu klip tersebut. Shortcut V

pada keyboard.

Track Select tool: Digunakan untuk memilih semua klip di trek dari suatu

titik tertentu, atau memilih beberapa track. Jika ada banyak track, gunakan

Shift + Drag, maka klip-klip di track lainnya akan ikut bergeser. Tools ini

memudahkan jika menyeleksi banyak klip. Shortcut M pada keyboard.

Ripple Edit tool: Tool untuk mengubah durasi klip atau memotong klip,

namun klip di samping kanannya otomatis akan bergeser. Shortcut B pada

keyboard.

Rolling Edit tool: Menyesuaikan titik edit antara dua klip tanpa

mempengaruhi sisa timeline. Shortcut V pada keyboard. Shortcut N pada

keyboard.

Rate Stretch tool: Tools ini untuk merubah kecepatan (memperlambat dan

mempercepat) klip. Fungsi tool ini sama dengan klik kanan klip lalu pilih

menu Speed/Duration. Shortcut X pada keyboard.

Razor tool: Memotong klip pada panel timeline. Tekan Shift + Klik maka

seluruh track akan terpotong tepat dimana tempat klik. Shortcut C pada

keyboard.

Slip tool: tool untuk menggeser isi/konten klip tanpa ada perubahan posisi

dan durasi di timeline. Klip disamping kiri dan kanannya tidak terpengaruh,

juga total durasi movie tetap/tidak berubah. Shortcut Y pada keyboard.

Slide tool: Tool untuk menggeser klip namun klip di samping kiri dan

kanannya akan terpotong atau memanjang, sedangkan total durasi tetap/tidak

berubah. Shortcut U pada keyboard.
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Pen tool: Tool ini gunanya untuk membuat keyframe (point atau titik) pada

klip. Dengan ada beberapa keyframe maka bisa dibuat grafiknya naik atau

turun. Shortcut P pada keyboard.

Hand tool: Berfungsi untuk menarik tampilan timeline kiri dan kanan.

Shortcut H pada keyboard.

Zoom tool: Klik pada timeline untuk memperbesar tampilan, atau klik kiri

dan tahan pada area tertentu pada panel timeline untuk memperbesar. Shortcut

tanda + dan - pada keyboard.

3.4. Bekerja dengan audio pada Premiere Pro

Gambar 3.5. Tampilan audio meters

Sumber: Jago

Panel lain yang kita harus perhatikan dalam editing adalah panel audio

meters (gambar 3.5). Audio meters berfungsi untuk memonitor audio yang

dimiliki oleh sebuah klip. Apabila over audio meters akan berwarna merah,
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namun apabila normal maka berwarna kuning hingga orange. Apabila audio

meters berwarna hijau, maka perlu dilakukan penyetelan untuk menambah

volume audio tersebut. Ada 2 jenis audio yang biasa diketahui yakni stereo

dan mono. Pada audio stereo memiliki 2 channel, sedangkan mono audio

hanya 1. Dari audio meters maka dapat diperhatikan apabila stereo maka

kedua kolom akan terisi indikator, namun apabila audio yang dimiliki mono

yang terisi hanya salah satu kolom.

Pada beberapa kasus, audio yang terdengar cukup keras atau pelan.

Untuk menyiasati hal ini, maka kita dapat melakukan pengaturan pada audio

gain. Berikut adalah beberapa cara untuk mengatur audio gain.

1. Klik kanan pada klip yang ada pada panel project atau bin. Lalu pilih

audio gain.

2. Klik kanan pada klip yang ada di panel timeline, kemudian pilih audio

gain.

Setalah dipilih, maka akan muncul dialog box sebagai berikut:

Gambar 3.6. Tampilan dialog box untuk setting gain pada audio.

Set gain to: Gunakan opsi ini untuk menentukan penyesuaian khusus untuk

klip yang dipilih.
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Adjust gain by: Gunakan opsi ini untuk menentukan penyesuaian tambahan

audio untuk klip. Misalnya, jika dimasukkan –3 dB, ini akan menyesuaikan

jumlah “Set gain to” menjadi –3 dB. Jika masuk ke menu ini untuk kedua

kalinya dan mengatur lagi –3 dB lainnya, jumlah “Set gain to” akan berubah

menjadi –6 dB, dan seterusnya.

Selain itu, pengaturan audio juga dapat dilakukan untuk beberapa klip

yakni dengan ‘normalizing audio’. Yang membedakan normalizing dengan

audio gain adalah normalizing dilakukan secara otomatis, sementara audio

gain dilakukan secara subyektif atau dengan mensetting sendiri.

Berikut adalah langkah untuk normalizing audio:

1. Pilih semua klip suara pada panel timeline yang akan dinormalize.

Pemilihan dapat dilakukan dengan seleksi dengan mouse atau memilih

klip secara satu persatu dengan menekan tombol Control.

2. Klik kanan klip yang dipilih dan pilih Audio Gain, atau tekan tombol G

pada keyboard.

3. Masukkan –8 untuk pilihan ‘Normalize All Peaks To’, dan klik OK.

4. Dengarkan kembali audio yang telah dinormalize. Atur ulang apabila

audio meters menunjukkan warna merah.

Untuk memisahkan antara audio dan video maka dapat dilakukan dengan

langkah berikut:

 Pilih klip yang ada pada panel timeline.

 Klik kanan > pilih unlink.

Secara otomatis maka audio dan video yang ada di panel timeline akan

terpisah. Untuk menghilangkan salah satunya, seleksi klip yang akan

dihilangkan lalu tekan ‘delete’ pada keyboard. Langkah kedua yang dapat

dilakukan adalah seleksi klip yang akan dihapus > klik kanan pada mouse >

pilih clear.
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3.5. Latihan soal dan jawaban

Soal

1. Apa perbedaan insert dan overwrite pada fitur yang ada pada source

monitor?

2. Bagaimana cara membuat potongan kasar (rough cut) menggunakan

source monitor?

3. Apa fungsi dari selection tool, razor, dan pen tool pada panel tools?

4. Apa perbedaan antara mono dan stereo pada audio?

5. Apa perbedaan antara normalization dan gain?

Jawaban

1. Insert menyisipkan klip pada timeline yang berdampak pada durasi

keseluruhan timeline, Overwrite menimpa klip pada timeline yang tidak

menyebabkan pertambahan durasi pada sequence di panel timeline.

2. Dengan menggunakan Mark In dan Mark Out pada source monitor dan

menurunkannya pada panel timeline dengan menggunakan tombol insert.

3. Selection Tools: Tool default/ alat default, digunakan untuk alat memilih

dan menggeser clip pada timeline.

Razor tool: Memotong klip pada panel timeline.

Pen tool: Tool ini gunanya untuk membuat keyframe pada klip.

4. Audio stereo memiliki 2 channel, sementara mono hanya memiliki satu

channel. Sebuah standar universal apabila merekam audio dari microphone

akan menjadi channel 1 dan audio dari sisi kanan akan menjadi channel 2

ketika merekam suara secara stereo.

5. Normalization bekerja secara otomatis berdasarkan puncak audio asli.

Sedangkan gain digunakan untuk manual setting.
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BAB IV

Membuat dan Menambahkan Teks

Tujuan Pembelajaran Umum

 Mahasiswa mampu membuat teks (title) pada Adobe Premiere Pro.

Tujuan Pembelajaran Khusus

Pembelajaran pada bab ini bertujuan untuk:

 Mampu membuat still title pada Premiere Pro.

 Mampu menambahkan gambar pada title.

 Mampu menambahkan text pada sequence.

 Mampu membuat credit title.
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4.1. Membuat text baru

Pada beberapa kondisi, diperlukan penambahan teks pada tayangan

supaya lebih jelas akan audio yang diucapkan. Untuk membuat teks, dapat

dipilh lewat menu:

File > New > Title (atau dengan short cut Ctrl+T, di Mac dapat Command+T)

Gambar 4.1. Tampilan Premiere Pro ketika akan membuat teks baru.

Setelah dipiliih, maka detail ukuran layar pada teks dapat diatur lewat

tampilan dialog box berikut.
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Gambar 4.2. tampilan dialog box untuk pengaturan dimensi pada teks.

Dimensi dari layar untuk teks dapat diatur panjang dan tingginya dan berilah

nama pada teks yang akan dibuat pada kolom ‘Name’. Setelah itu, maka

tampilan akan berubah sebagai berikut:

Gambar 4.3. Tampilan Title Designer Panel

Sumber: Jago, 2016

Title Properties Panel: Merupakan panel tempat mengatur teks yang

ditampilkan seperti jenis font, ukuran, warna, efek yang akan digunakan, serta

berbagai pengaturan detail tentang teks.

Title Tools Panel: Merupakan panel yang berisi berbagai peralatan (tools)

dan menambahkan bentuk yang diinginkan pada teks.

Title Action Panel: Merupakan panel yang berisi tentang bermacam action

yang dapat diterapkan pada teks seperti margin dan posisi teks dalam frame.
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Pada panel Title Actions, klik tombol Horizontal Center dan Vertical Center

untuk meluruskan objek teks ke tengah layar.

Title Style Panel: Merupakan panel yang berisi bermacam pilihan desain teks

yang disediakan secara default oleh Premiere Pro.

Pada panel Title menawarkan 3 pendekatan untuk membuat sebuah teks,

masing-masing menawarkan opsi arah teks horizontal dan vertikal.

Gambar 4.5. Pilihan pada pembuatan teks di panel Title Tools.

Sumber: Jado, 2016

Pada panel Title Tools, dapat memilih tool dari kolom kiri atau kanan. Ini

menentukan apakah teks akan muncul horizontal atau vertikal.

Beberapa yang perlu dipertimbangkan dalam pembuatan teks (Jago, 2016):

a) Pemilihan font. Sebaiknya font yang dipilih dapat diibaca secara jelas

dan terlihat. Dengan gaya yang tidak terlalu berlebihan, akan

membuat teks lebih mudah untuk dibaca.

b) Pemilihan warna. Warna yang dipilih untuk teks sebaiknya kontras

dengan background yang digunakan. Kombinasi beberapa pengaturan

seperti bayangan, outline, maupun background yang tersedia di panel
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Title Properties dapat memberikan sentuhan berbeda pada teks yang

akan ditampilkan.

c) Peletakan font. Peletakan font hendaknya disesuaikan dengan

kebutuhan di dalam sebuah scene. Font yang menutupi seluruh layar

tentunya akan menganggu kenyamanan penonton.

d) Batas aman judul. Ketika akan menambahkan teks maka ada 2 kotak

yang secara otomatis muncul. Kotak ini disebut dengan safe margin.

Batas aman untuk teks supaya jelas terlihat (tanpa terpotong nantinya)

adalah pada batas kotak yang terdalam. Usahakan teks agar tidak

melampaui kotak terluar dari safe margin.

Gambar 4.5. Safe Margin pada penambahan teks.

4.2. Menambahkan gambar pada title

Pada title, editor dapat menambahkan gambar untuk berbagai tujuan,

misalnya menambahkan logo perusahaan, logo acara, dan sebagainya.

Menambahkan gambar ke dalam desain title menggunakan format file biasa,

termasuk vektor (.ai, .eps) dan gambar (.psd, .png, .jpeg). Berikut adalah

langkah penambahan gambar pada tampilan Title Designer.

1. Masukkan file gambar yang diinginkan dengan memilih menu Title >

Graphic > Insert Graphic.
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2. Dengan tool selection, drag logo ke posisi yang dimana diinginkan

pada title. Atur ukuran, opacity, rotasi, atau skala dari gambar.

Gunakan tombol Shift untuk mengubah skala gambar untuk

menghindari distorsi gambar.

3. Gunakan Title Properties untuk melakukan setting terentu pada title,

misalnya merubah font, mengganti ukuran font, menambahkan stroke,

dan sebagainya.

Kemudian tutup tampilan Title Designer apabila pengaturan telah selesai

dilakukan.

4.3. Menambahkan text pada sequence

Setelah title telah dibuat, title tersebut dapat ditambahkan pada

sequence yang ada di panel timeline sama seperti menambahkan aset lain ke

panel timeline. Caranya, drag title dari panel project atau bin ke track yang

ada di timeline.

Perhatikan peletakan title di panel timeline. Apabila menginginkan title

untuk menumpuk pada video lain, maka letakkan title pada track video di atas

klip yang diinginkan.

Jika ingin judul ditambahkan di awal sequence namun sudah ada klip di

awal, maka Ctrl-drag (Windows) atau Command-drag (Mac OS) title di awal

untuk melakukan ripple insert, di mana semua video lainnya secara otomatis

digeser untuk memberi ruang bagi title.

Pengaturan durasi untuk title dapat dilakukan sama dengan pengaturan

durasi untuk klip lain di panel timeline. Caranya dengan drag di bagian akhir

title dengan tools seperti Selection Tools atau Ripple Edit Tools.
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4.4. Membuat Credit Title

Selesai melihat sebuah film, maka penonton akan disuguhi list yang

berisi seluruh kru pembuat film dalam bentuk tulisan yang secara berurutan

berjalan dari bawah ke atas, itulah yang disebut dengan credit title. Credit

Title dapat dibuat juga dengan Adobe Permiere Pro, berikut

langkah-langkahnya:

Pilih Title > New Title > Default Roll.

Kemudian, beri nama title dan klik OK.

Pilih tool Type, ketik teks yang cukup untuk mengisi layar secara vertikal,

buat kredit placeholder seperti yang ditunjukkan gambar 4.6., tekan tombol

Enter (Windows) atau Return (Mac OS) setiap baris terakhir.

Tips: Gunakan panel Title Properties untuk mengubah format title yang

diinginkan.

Gambar 4.6. Tampilan credit title pada title designer
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Klik tombol opsi Roll/Crawl ( ). Yang ada di bagian tengah atas layar title

designer (lihat gambar 4.7).

Gambar 4.7. Tampilan posisi Roll/Crawl

Apabila sudah dipilih, maka terdapat beberapa opsi sebagai berikut (gambar

4.8):

Still: Mengatur title untuk diam/tetap.

Roll (scroll text vertically): Mengatur title secara vertikal.

Crawl Left, Crawl Right: Mengatur title secara horizontal kiri atau kanan.

Start Off Screen: Mengatur apakah bagian kredit dimulai dari luar layar dan

terus bergulir atau dimulai di tempat saat meletakkannya di Title Designer.

End Off Screen: Menunjukkan apakah kredit bergulir sepenuhnya dari layar

atau berakhir di layar.

Preroll: Mengatur jumlah frames untuk ditunda sebelum teks pertama muncul

dilayar.
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Ease-In: Menentukan jumlah frames pada bagian awal secara bertahap

meningkatkan kecepatan roll atau crawl dari nol ke kecepatan penuh.

Ease-Out: Menentukan jumlah frames untuk memperlambat kecepatan roll

atau crawl pada bagian akhir.

Postroll: Menentukan jumlah frames yang dimainkan setelah roll atau crawl

berakhir.

Gambar 4.8. Tampilan opsi Roll/Crawl

Centang Start Off Screen dan End Off Screen lalu klik OK. Kemudian tutup

title designer.

Untuk menampilkan credit title yang telah dibuat, maka drag title yang ada di

panel project di dalam track video tertentu di Timeline diatas video klip.

Tekan tombol spacebar untuk menampilkan Rolling Credits.
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4.5. Latihan soal dan jawaban

Soal

1. Di bagian mana pada title designer box yang berfungsi untuk

mengganti jenis dan ukuran font?

2. Mengapa menampilkan safe margin title?

3. Apa fungsi dari safe margin?

4. Bagaimana cara memasukkan grfiis/gambar pada title?

5. Bagaimana membuat title berjalan dari bawah frame ke atas?

Jawaban

1. Jenis dan ukuran font dapat diubah pada Title Properties Panel.

2. Beberapa perangkat TV memotong tepi gambar sehingga

memungkinkan teks akan hilang (terpotong) apabila berada di luar

safe margin.

3. Menjaga teks dalam batas aman sehingga penonton akan melihat

semua teks (title) yang akan dtayangkan.

4. Ketika kotak title designer aktif, maka dapat memilih menu Title >

Graphic > Insert Graphic.

5. Dengan memilih Roll pada opsi title.
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BAB V

Transisi pada Premiere Pro

Tujuan Pembelajaran Umum

 Mahasiswa mampu menerapkan transisi video dan audio pada Adobe

Premiere Pro.

Tujuan Pembelajaran Khusus

Pembelajaran pada bab ini bertujuan untuk:

 Mampu memahami transisi pada editing video.

 Mampu menerapkan transisi video.

 Mampu menerapkan transisi audio.
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5.1. Mengenal transisi pada video

Transisi adalah alat storytelling standar dalam pengeditan video.

Sebagian besar penonton memahami bahasa transisi dan akan menafsirkan

penggunaannya degan benar. Misalnya, lambatnya memudar menjadi hitam

di akhir scene mengindikasikan bahwa scene telah selesai.

Banyak tayangan TV dan feature film menggunakan pengeditan cut to

cut. Jarang sekali melihat menggunakan banyak transisi. Mengapa? Karena

efek harus digunakan jika dapat memberikan manfaat tambahan tertentu, dan

paling sering tidak ada efek transisi. Faktanya, terlalu banyak transisi akan

mengganggu penonton. Secara umum, transisi pada sebuah film/video ada 3

yang sering digunakan, yakni:

1. Cut: transisi yang digunakan untuk menjelaskan kejadian yang

berlangsung pada satu waktu yang sama.

2. Dissolve: transisi yang digunakan untuk menjelaskan kejadian yang

memiliki jangkan waktu cukup panjang. Misalnya: satu jam kemudian.

3. Fade: transisi yang digunakan utuk menjelaskan kejadian yang

berlangsung pada rentang waktu yang sangat lama. Misalnya satu

tahun berikutnya.

Selain menunjukkan perbedaan waktu, transisi juga dapat menjelaskan

adanya perbedaan latar/setting pada film/video. Pada premiere pro, untuk

menambahkan berbagai macam transisi dapat diperoleh pada panel effects.

Menerapkannya juga cukup sederhana; yaitu dengan proses drag-and-drop.

Berikut adalah tampilan detail pada panel effects. Untuk memudahkan

pencarian transisi tertentu dapat menggunakan kolom Search, dibagian atas

panel, untuk menemukan lokasi berdasarkan nama atau kata kunci, atau dapat

manual membuka di efek folder.
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Gambar 5.1. Tampilan Panel Effects pada Premiere Pro

5.2. Transisi pada video

Premiere Pro memberikan beberapa efek transisi video untuk dipilih.

Banyak opsi tersedia di transisi video (video transition) pada panel Effects.

Menerapkan transisi satu sisi

Berikut adalah langkah untuk menambahkan transisi satu sisi (di awal atau

di akhiir sebuah klip):

Di panel Effetcs, buka Video Transitions > pilih grup Dissolve.

Temukan efek Cross Dissolve.

Drag dan drop efek dissolve ke dalam bagian awal dari klip (lihat gambar

5.2).

Gambar 5.2. Meletakkan transisi di awal klip.
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Bagian yang diseleksi (warna berbeda) merupakan penanda efek transisi

akan ditambahkan.

Tambahkan pula efek dissolve ke bagian akhir dari klip.

Gambar 5.3. Meletakkan transisi di akhir klip.

Menerapkan transisi di antara 2 klip

Berikut adalah langkah untuk menerapkan transisi di antara 2 klip:

Posisikan playhead (garis biru vertikal yang ada pada panel timeline)

diantara 2 klip yang akan diberi transisi.

Gambar 5.4. Transisi diletakkan di antara 2 klip.

Untuk memperpanjang durasi transisi dapat dilakukan dengan 2 cara:

 Menggunakan selection tool pada transisi di panel timeline.

 Merubah durasi lewat panel Effect controls di source monitor.
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Gambar 5.4. Durasi transisi dapat diperpanjang pada panel effect controls

pada source monitor.

Silahkan bereksperimen dengan berbagai pilihan video transition yang ada di

panel effects.

Menerapkan transisi ke berbagai klip sekaligus

Berikut langkah-langkah untuk menerapkan transisi pada beberapa klip

sekaligus:

Seleksi semua klip yang akan diberikan transisi.

Pergi ke menu Sequence (posisi di atas) dan pilih Apply Default

Transitions ke Selection (lihat gambar 5.5).
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Gambar 5.5. Menerapkan default transition pada klip yang diseleksi.

Transisi default dapat diketahui dari kotak yang memilki stroke biru pada

panel effect. Untuk mengganti transisi default maka pilih transisi yang

dinginkan > klik kanan mouse > pilih set as default transition (gambar 5.6).

Gambar 5.6. Merubah transisi default pada panel effects.

5.3. Transisi pada audio

Sama seperti transisi pada video, transisi untuk audio juga dapat

ditemukan di tempat yang sama dan beragam pilihan. Cara penggunaannya
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pun juga cukup mudah, bahkan relatif sama, dengan penerapan transisi video.

Pilihan yang diberikan oleh Premiere Pro tidak banyak untuk transisi audio

tetapi sudah cukup untuk meningkatkan kuaitas audio dari tayangan. Ada 3

pilihan audio transition pada Adober Premiere Pro, berikut penjelasannya:

Constant Gain: Constant Gain crossfade (seperti namanya) mentransisikan

audio dengan menggunakan pengauatan audio konstan (volume) diantara klip.

Beberapa orang menganggap transisi ini berguna. Namun ini dapat membuat

transisi dalam audio tiba-tiba saat saat suara suara klip outgoing menghilang

dan suara klip incoming menghilang dengan volume yang sama. Constant

Gain crossfade paling berguna dalam situasi dimana tidak ingin banyak

pencampuran antara 2 klip tetapi lebih banyak penggabungan diantara 2 klip.

Constant Power: Transisi audio default di Premiere Pro menciptakan transisi

yang mulus dan bertahap antara 2 klip audio. Constant Power crossfade

bekerja mirip dengan video dissolve namun versi audio. Saat crossfade

diterapkan, klip outgoing perlahan-lahan menghilang pada awalnya dan

kemudian semakin cepat menjelang akhir klip. Pada klip incoming, justru

sebaliknya. Tingkat audio meningkat cepat diawal klip incoming dan

perlahan menuju akhir transisi. Crossfade ini berguna dalam kebanyakan

situasi dimana ingin menggabungkan audio antara 2 klip.
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Exponential Fade: Efek ini mirip dengan Constant Power crossfade. Transisi

Exponential Fade adalah fade yang cukup mulus antar klip. Transisi ini

menggunakan kurva logaritmik untuk memudarkan audio. Beberapa memilih

transisi Exponential Fade saat melakukan transisi satu sisi (seperti

memudarkan klip dari diam di awal atau akhir program).

Menerapkan transisi audio

Ada beberapa cara untuk menerapkan crossfade audio pada sequence.

Tentu saja, drag dan drop transisi audio seperti yang dilakukan pada transisi

video, tetapi ada shortcut yang berguna untuk mempercepat prosesnya.

Transisi audio memiliki durasi default, diukur detik atau frames.

Durasi default dapat diubah dengan memilih Edit > Preferences > General

(Windows) atau Premiere Pro > Preferences > General (Mac OS). Metode

yang sama dari transisi video dapat digunakan pada penerapan transisi audio,

baik untuk satu sisi, diantara 2 audio, maupun untuk berbagai audio.
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5.4. Latihan soal dan jawaban

Soal

1. Bagaimana menerapkan transisi default pada banyak klip?

2. Bagaimana mencari transisi berdasarkan nama?

3. Bagaimana mengganti transisi dengan yang lain?

4. Bagaimana cara mengganti transisi default?

5. Apa cara mudah untuk memudar (fade) audio klip di awal atau di

akhir?

Ulasan Jawaban

1. Pilih klip yng ada di Timeline dan kemudian memilih Sequence >

Apply Default Transitions ke klip yang diseleksi.

2. Dimulai mengetik nama transisi di kotak pencarian di panel Effects.

Setelah mengetik, Premiere Pro menampilkan semua efek dan transisi

(audio dan video) yang memiliki kombinasi huruf yang dicari. Ketik

lebih banyak huruf untuk mempersempit pencarian.

3. Drag transisi pergantian diatas transisi yang ingin diganti. Yang baru

secara otomatis mengganti yang lama sambil mengadopsi timing.

4. Pilih transisi yang dinginkan pada panel effects > klik kanan mouse >

pilih set as default transition

5. Cara mudah untuk menerapkan fade pada audio in atau out dengan

menerapkan transisi crossfade audio di awal atau akhir klip.
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BAB VI

Multicamera dan Chroma Key

Tujuan Pembelajaran Umum

 Mahasiswa mampu mengedit gambar menggunakan teknik multi

camera serta menerapkan Chroma Key pada editing.

Tujuan Pembelajaran Khusus

Pembelajaran pada bab ini bertujuan untuk:

 Mampu memahami alur kerja dalam proses multi camera

 Mampu membuat multi camera sequence

 Mampu mengedit multi camera

 Mampu menerapkan chroma key pada editing
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6.1. Alur Kerja dalam proses multi camera

Dalam beberapa kesempatan, proses produksi dari sebuah konten audio

visual membutuhkan lebih dari 1 kamera dengan alasan estetika hingga

mendapatkan momen yang pas. Oleh karenanya, Premiere Pro memberikan

kemudahan untuk bekerja/mengedit secara langsung dengan banyak kamera.

Proses pengeditan multikamera memiliki alur kerja standar, Ada enam tahap

yang dilalui, diantaranya:

a) Impor file rekaman. Perhatikan frame rate kamera dan ukuran layar

dari file yang dimiliki. Namun dapat juga dilakukan pengaturan

nantinya.

b) Tentukan titik sinkronisasi. Tujuannya adalah untuk menjaga agar

berbagai sudut pengambilan berjalan selaras satu sama lain sehingga

editor dapat beralih di antara keduanya dengan mulus. Editor perlu

mengidentifikasi titik waktu yang ada di semua angle kamera untuk

menyinkronkan atau menggunakan kode waktu yang cocok. Sebagai

alternatif, dapat juga menyinkronkan secara otomatis jika semua trek

memiliki audio yang sama, misalnya bunyi clapper atau teriakan

‘action’.

c) Buat multi camera sequence pada panel project. Berbagai angle

kamera, dibuat dalam sebuah sequence khusus yang bernama

multicamera source sequence. Ini pada dasarnya adalah sequence

yang berisi video dengan berbagai macam angle kamera

d) Tambahkan multi camera sequence ke sequence baru untuk diedit.

Sequence baru ini adalah sequence master target multikamera.

e) Rekam hasil edit multi camera. Tampilan khusus di Program Monitor

(tampilan multi camera) memungkinkan editor memilih angle

kamera yang berbeda dalam keadaan diputar (play).
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f) Menyesuaikan dan memperbaiki hasil edit. Setelah pengeditan kasar

dibuat, editor menyesuaikan standar editing dan trimming tools pada

panel timeline.

Catatan yang perlu menjadi perhatian, kemampuan komputer dan hard drive

sangat mempengaruhi kinerja pengeditan menggunakan metode multi

camera.

6.2. Membuatmulti camera sequence

Langkah pertama dalam membuat multi camera sequence adalah

menentukan titik sinkronisasi. Dapat dipilih dari 5 metode yang akan

digunakan untuk referensi sinkronisasi. Metode yang dipilih sebagian

bergantung pada pilihan personal dan sebagian lagi tentang cara pengambilan

gambar.

a) In points: Menentukan in point pada tiap klip. Metode ini sangat

efektif selama semua kamera berputar sebelum aksi critical dimulai

b) Out points: Metode sinkronisasi ini sama dengan In points, tetapi

menggunakan titik keluar (Out points). Sinkronisasi titik keluar (Out

points) sangat ideal saat semua kamera mengambil aksi critical

diakhir, tetapi dimulai pada waktu yang berbeda.

c) Time code: Banyak kamera profesional memungkinkan timecode

disinkronkan di beberapa kamera. Beberapa kamera dapat

disinkronkan dengan menghubungkannya ke sumber sinkronisasi

umum atau dengan dengan mengkonfigurasi kamera secara hati-hati

dan menyinkronkan proses kemarana. Dalam banyak kasus, nomor

jam diimbangi untuk mengidentifikasi nomor kamera. Misalnya,

kamera 1 akan dimulai pada 1:00:00:00, dan kamera 2 dimulai

dengan 2:00:00:00 serta bisa memilih untuk mengabaikan nomor jam

saat menyinkronkan timecode.
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d) Clip marker: Titik masuk (In points) dan ttik keluar (Out points)

dapat secara tidak sengaja terhapus dari klip. Jika ingin menandai

klip dengan cara yang kuat, dapat menggunakan clip marker untuk

mengidentifikasi titik sinkronisasi umum. Marker lebih sulit untuk

dihilangkan secara tidak sengaja dari klip. Marker juga dapat

didasarkan pada bagian dari aksi, mungkin sebuah peristiwa di

tengah-tengah rekaman yang ditangkap semua kamera.

e) Audio: Jika setiap kamera merekam audio (bahkan jika kualitas audio

buruk dari mikrofon internal kamera), Premiere Pro dapat

menyinkronkan klip secara otomatis. Hasilnya dengan metode ini

bergantung pada audio yang cukup bersih. Suara clapper atau terakan

‘action’ membantu dalam melakukan sinkronisasi secara audio.

6.3. Mengedit multi camera

Langkah pertama adalah mengimpor semua file video pada panel project,

kemudian klik kanan untuk membuat bin baru. Beri nama bin tersebut dengan

multicam. Pilih dan pindah semua klip multicam yang sudah diimpor ke

dalam bin tersebut. Lalu klik kanan pada bin tersebut, dan pilih ‘create

Multi-Camera Source Sequence’. Perhatikan gambar 6.1 di bawah ini.
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Gambar 6.1. membuat sequence untuk multi camera

Sumber: Premiere Gal

Kemudian akan muncul dialog box untuk memilih sinkronisasi yang telah

disebutkan di bab 6.2. sebelumnya. Pilih sesuai dengan kebutuhan yang

diinginkan. Setelah itu pilih ‘ok’.
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Gambar 6.2. Dialog box untuk menentukan sinkronisasi.

Setelah terbentuk, maka berikutnya adalah menentukan multiicam

target sequence yang nantinya akan diedit lewat panel timeline. Caranya

adalah klik kanan untuk multi camera sequence yang ada di pada panel

project, kemudian klik kanan, dan pilih ‘new sequence from clip’ (perhatikan

gambar 6.3). Maka secara otomatis, semua klip dari angle kamera yang

berbeda akan disatukan pada panel timeline.
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Gambar 6.3. Membuat sequence multi camera baru pada timeline

Sumber: Premiere Gal

Setelah sequence baru terbentuk pada panel timeline, maka kita hanya

melihat tampilan yang diambil dari satu kamera saja. Untuk mengaktifkan

editing multi camera, maka kita perlu menekan tombol toggle multi-camera

view pada program monitor (lihat gambar 6.4). Apabila tombol tersebut tiidak

tampak, maka pilihan tersebut dapat ditemukan pada tanda + (pojok kanan

bawah) pada program monitor.

Gambar 6.4. Tombol toggle multi-camera view pada program monitor

Sumber: Premiere Gal
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Sesudah mengaktifkan Tombol toggle multi-camera view pada program

monitor, maka tampilan program monitor akan berubah menjadi 2 bagian

besar yakni tampilan monitor dari semua angle kamera dan tampilan hasil

jadi editing (composite view).

Gambar 6.5. Tampilan program monitor yang terbagi menjadi 2.

Sumber: Premiere Gal

Posisikan play head (garis berwarna biru pada timeline) pada bagian

awal klip di timeline, kemudian play (dengan menggunakan spasi atau

menekan tombol play pada program monitor). Ketika tombol play ditekan,

maka editor dapat melakukan pengeditan dengan menggunakan pointer

mouse dan klik langsung pada bermacam angle kamera yang diinginkan pada

program monitor sebelah kiri. Pastikan storke pada angle kamera berwarna

merah yang menandakan perekaman sedang berlangsung (lihat gambar 6.6).

Angka pada keyboard juga dapat digunakan sebagai pengganti

pointer mouse untuk memilih kamera angle. Nomor 1 akan mewakili kamera

1, nomor 2 akan mewakili kamera 2, dan seterusnya. Perpindahan angle

kamera dapat dilakukan dengan posisi play pada program monitor.
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Gambar 6.6. Stroke berwarna merah menandakan recording sedang

dilakukan.

Sumber: Premiere Gal

Setelah pemilihan angle kamera selesai, maka tampilan panel timeline akan

terpotong-potong sesuai dengan angle kamera yang editor pilih. Penggunaan

tools pada tiap potongannya sangat dimungkinkan, seperti penggunaan pada

klip biasanya. Penambahan transisi video juga dapat dilakukan pada klip yang

telah terpotong.
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Gambar 6.7. Tampilan timeline setelah pemotongan lewat multicam editing.

Sumber: Premiere Gal

6.4. Mengganti green screen dengan background baru

Penggunaan green screen dalam produksi audio visual dewasa ini

bukanlah barang baru. Penggunaan green screen memudahkan edior maupun

visual efek artis bekerja dengan mudah untuk mengganti background. Editor

dapat menggunakan Premiere Pro untuk mengganti background dengan

mudah.

Fase pertama pengomposisian green screen adalah menggambar

opacity mask pada obyek yang dituju. Berikut adalah langkah-langkahnya:

1. Tempatkan klip background yang baru di video track 1 pada panel

timeline. Kemudian tempatkan klip yang memiliki green screen ke video

track 2. Samakan durasi kedua klip tersebut.

2. Pada panel Effect Controls, buka pengaturan Opacity dengan segitiga di

bagian kanan tulisan ‘opacity’.

3. Pilih tool Free Draw Bezier (dengan icon pena) (lihat gambar 6.8).

Gambar 6.8. tool Free Draw Bezier pada panel Effect Controls

Sumber: Dockery,

4. Buat titik-titik yang mengelilingi subyek di program monitor. Satukan

titik yang dibuat terakhir dengan titik awal. Maka green screen pada subyek

akan terseleksi, dan background baru mulai terlihat.
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Gambar 6.9. Titik seleksi yang mengelilingi obyek dengan latar green screen.

Sumber: Dockery

5. Drag Ultra Key (di panel Video Effects > grup Keying) pada subyek

yang telah terseleksi di panel timeline.

6. Pada efek ultra key, key color menjadi hijau dengan menggunakan

picker (icon seperti pedang) diarahkan ke green screen di sekitar subyek.

Kemudian pilihan Output diganti alpha channel (lihat gambar 6.10). Cek

dengan memperbesar scale pada program monitor untuk melihat seleksi yang

dilakukan.

Gambar 6.10. Pengaturan efek Ultra Key Panel Effect Controls.

Sumber: Dockery
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7. Apabila seleksi belum detail, maka dapat memilih setting pada efek ultra

key. Editor dapat mengatur ulang setting hingga hasil yang diharapkan

(seleksi cukup bersih).

Gambar 6.11. Pengaturan setting pada efek Ultra Key pada Panel Effect

Controls.

Sumber: Dockery

8. Apabila seleksi sudah dirasa cukup baik, maka Output pada efek Ultra

Key di panel Effect Controls diubah menjadi Composite. Hasil seleksi green

screen dengan background baru akan tampak.

9. Putar kembali sequence untuk memastikan klip terlihat dengan baik dan

benar.
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6.5. Latihan soal dan jawaban

Soal

1. Bagaimana alur kerja dalam proses multi camera?

2. Sebutkan 5 jenis sinkronisasi pada klip multi camera?

3. Bagaimana cara membuat multi camera sequence pada panel project?

4. Apa efek yang digunakan untuk mengganti green screen/blue screen

dengan background lain?

5. Di bagian panel mana, pengaturan keying dapat dilakukan?

Jawaban

1. Impor file rekaman, menentukan titik sinkronisasi, membuat multi

camera sequence pada panel project, menambahkan multi camera sequence

ke sequence, Rekam hasil edit multi camera, Menyesuaikan dan memperbaiki

hasil edit.

2. In points, Out points, timecode, audio, and markers.

3. Seleksi beberapa klip yang dibutuhkan > klik kanan, pilih create

multi-camera source sequence.

4. Ultra Key effect. Dapat juga dipilih beberapa efek lain pada panel effects

dengan mengetikkan ‘key’ pada kolom pencarian.

5. Pada Effect Controls Panel di source monitor.



TEKNIK PENYUNTINGAN DIGITAL

67

BAB VII

Exporting Media

Tujuan Pembelajaran Umum

 Mahasiswa mampu membuat video dengan baik dan benar sesuai

hasil akhir yang diharapkan.

Tujuan Pembelajaran Khusus

Pembelajaran pada bab ini bertujuan untuk:

 Mampu melakukan export single frame (image).

 Mampu melakukan setting export dengan benar sesuai tujuan akhir.

 Mampu memahami fungsi Adobe Media Encoder dalam melakukan

export.
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7.1. Mengexport single frame (image)

Saat proses mengedit, ada kemungkinan ingin export single frame

untuk dikirim ke tim atau klien untuk preview. Export gambar dapat juga

digunakan sebagai thumbnail dari video yang dibuat pada video sharing

platform seperti Youtube.

Untuk melakukan export single frame dapat dilakukan dengan cara Di

Program Monitor, menekan tombol Export Frame ( ) dibagian kanan

bawah program monitor. Apabila icon tersebut tidak tampak, maka dapat

dicari pada Button editor yang bersimbol tanda + di bagian pojok kanan

bawah Program monitor. Shortcut untuk export single frame yakni dengan

menekan Shift+Control+E (Windows) atau Shift+E (Mac OS) pada keyboard.

Kemudian akan muncul dialog box seperti di bawah ini untuk memasukkan

nama file.

Gambar 7.1. Dialog box untuk export single frame
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Gunakan menu Format untuk memilih format gambar yang akan diexport.

Berikut penjelasan beberapa format:

JPEG, PNG, GIF, dan BMP berfungsi dengan baik untuk alur kerja grafik

(seperti penggunaan gambar di Internet)

TIFF, Targa, dan PNG cocok untuk alur kerja animasi dan cetak.

DPX sering digunakan untuk alur kerja cinema digital atau color-grading.

Kemudian klik tombol Browse untuk memilih lokasi dari tempat

penyimpanan gambar. Setelah nama dan lokasi penyimpanan ditentukan

maka tekan ‘ok’.

7.2. Mengexport master copy

Setelah editing selesai dilakukan, maka sekarang waktunya untuk

menggabungkan seluruh potongan menjadi video yang utuh. Maka langkag

selanjutnya adalah export media. Sebelum melakukan export media, pastikan

bahwa timeline telah diseleksi/dipilih terlebih dahulu. Timeline yang telah

dipilih akan muncul tepian berwarna biru.

Export media dapat dilakukan dengan memilih menu:

File > Export > Media

Atau dengan menggunakan shortcut Control+M (pada Windows) atau

Command+M (Pada Mac)

Setelah itu, akan muncul tampilan sebagai berikut:
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Gambar 7.2. Tampilan menu export media

Pengaturan pertama yang dilakukan adalah menentukan area mana yang akan

kita export di timeline. Pilihan tersebut ada di bagian kiri bawah dengan

menentukan ‘Source Range’. Berikut adalah pilihan untuk ‘Source Range’:

Gambar 7.3. Pilihan pada Source Range

Secara default Premiere Pro akan ada pada pilihan Sequence In/Out. Pilihan

ini dapat dipilih tanpa mengubah setting lainnya. Tetapi dapat juga dipilih

setting yang lain sesuai dengan kebutuhan.
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Setelah itu, langkah selanjutnya adalah memilih format file output untuk

video. Berikut adalah tampilan pilihan format file yang dapat dipilih:

Secara umum, untuk menjadikan hasil dalam bentuk .mp4 maka dipilih

format file H.264. Berikut adalah penjelasan beberapa file format yang biasa

diipilih selain H.264:

AAC Audio: Format Advanced Audio Coding adalah format file audio saja

yang paling sering digunakan dengan encoding H.264. Ini lebih efisien dari

yang biasanya diketahui yaitu codec MP3.

AIFF: Audio Interchange File Format adalah adalah format file audio saja

yang tidak terkompresi.

H.264: Format ini sekarang lebih fleksibel dan tersebar luas penggunaannya,

dengan banyak preset untuk perangkat seperti iPod dan Apple TV dan TiVo

Series3 SD dan HD dan beberapa layanan seperti Youtube dan Vimeo. File

H.264 dapat dimainkan di smartphone atau digunakan sebagai file perantara

kecepatan tinggi, berkualitas tinggi untuk bekerja di editor video lain.
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H.264 Blu-ray: Opsi ini memproduksi file H.264 yang dikonfigurasikan

secara spesial untuk Blu-ray Discs.

JPEG: Pengaturan ini dibuat untuk serangkaian gambar.

MP3: Ini format audio yang dikompresi secara popular karena menghasilkan

file yang relatif lebih kecil dengan suara yang bagus di telinga.

MPEG2: Format file ini utamanya digunakan untuk DVDs dan Blu-ray Discs.

Preset dalam grup ini memungkinkan untuk menghasilkan file yang dapat

didistribusikan untuk diputar di komputer lain. Banyak penyiar menggunakan

MPEG2 sebagai format untuk pengiriman digital.

MPEG2-DVD: ini membuat file audio dan video MPEG2 yang sesuai

dengan standar DVD discs.

MPEG4: Ini menghasilkan file H.263 3GP berkualitas lebih rendah untuk

diputar di ponsel lama.

P2 Movie: Ini menghasilkan media Panasonic P2 standar.

PNG: Ini adalah format gambar diam tanpa kerugian tapi efisien untuk

penggunaan internet atau untuk rangkaian gambar yang mengandung

tranparansi. Tidak seperti format gambar diam lainnya, file PNG dapat

termasuk saluran alpha.

QuickTime: Format dapat menyimpan media menggunakan satu dari

beberapa codec. File QuickTime menggunakan ekstensi .mov, apapun

codec-nya.

TIFF: Format gambar diam berkualitas tinggi yang populer menawarkan opsi

keduanya lossy dan lossless.

AVI: Jenis file video yang memiliki ukuran sangat besar karena tidak

terkompres.

Jika format file telah ditentukan maka langkah selanjutnya adalah memilih

lokasi tujuan eksport dan juga memberikan nama dengan klik bagian ‘output
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name’. Maka secara otomatis akan muncul dialog box untuk menentukan

lokasi dan menambahkan nama.

Tips:

 Untuk ouput yang paling baik (tajam, bersih, dan cerah) gunakan AVI

dengan Codec Xvid. Hasil yang nyaris sama dicapai dengan Codec

DivX atau MPEG4. Selain kualitas baik filenya pun berukuran sangat

kecil.

 Jangan import/menggunakan footage dengan format MPG (baik

VCD atau DVD) karena setelah dirender ulang hasilnya sangat pecah

dan pucat. Oleh karena itu selalu gunakan AVI dengan Codec DV

atau tanpa Codec sama sekali (Uncompressed).

Langkah selanjutnya adalah menentukan opsi video dan audio tab

untuk menyesuaikan output video yang dinginkan. Cek dimensi ukuran layar

serta frame rate di tab video. Sementara untuk tab audio, pastikan bahwa

Bitrate Setting pada 320 kbps. Setting lainnya dapat diabaikan sesuai dengan

setting default Premiere Pro. Maka setting selesai dan dapat diteruskan untuk

export.

Ada 2 pilihan untuk export, yakni:

Queue: Dengan menekan tombol Queue maka file akan dikirimkan ke Adobe

Media Encoder, dan kita dapat melanjutkan pekerjaan di Premiere Pro saat

export masih berlangsung. Lebih lanjut akan dibahas pada 7.3.

Export: Pilihan langsung yang dapat dipilih untuk menghasilkan video yang

utuh. Namun tidak dapat mengedit di Premiere Pro hingga hasil export

selesai.
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7.3. Bekerja dengan Adobe Media Encoder

Adobe Media Encoder adalah aplikasi mandiri yang dapat dijalankan

secara independen atau diluncurkan dari Premiere Pro. Satu keuntungan

menggunakan Adobe Media Encoder adalah dapat mengirim pekerjaan

encoding langsung dari Premiere Pro dan kemudian melanjutkan pengeditan

saat encoding diproses. Untuk mengekspor dari Premiere Pro ke Adobe

Media Encoder, dapat dipilih queue untuk export.

Berikut beberapa fitur paling berguna yang dapat ditemukan di Adobe

Media Encoder:

• Tambahkan file tambahan: Anda dapat menambahkan file langsung ke

Adobe Media Encoder dengan memilih File> Add Source. Anda bahkan

dapat drag and drop file ke dalamnya dari Windows Explorer (Windows)

atau Finder (Mac OS).

• Import sequence Premiere Pro secara langsung: Anda dapat memilih File>

Add Premiere Pro Sequence untuk memilih file proyek Premiere Pro dan

memilih urutan untuk diencode (tanpa membuka Premiere Pro).

• Render komposisi After Effects secara langsung: Editor dapat mengimpor

dan me-encode komposisi dari Adobe After Effects dengan memilih File>

Add After Effects Composition. Tanpa perlu membuka Adobe After Effects.

• Use a watch folder: Apabila ingin mengotomatiskan beberapa tugas

encoding, maka dapat membuat folder watch dengan memilih File> Add

Watch Folder dan kemudian menetapkan preset ke folder tersebut. File media

yang ditempatkan ke dalam folder secara otomatis dikodekan ke format yang

ditentukan di preset.

• Mengubah sequence: Editor dapat menambah, menduplikasi, atau

menghapus tugas apa pun dengan menggunakan tombol yang mirip dan

menambahkan tugas apa pun yang belum mulai me-encode ke tempat mana

pun dalam antrean. Jika belum mengatur queue untuk memulai secara
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otomatis, klik tombol queue (ikon play) untuk memulai encoding. Adobe

Media Encoder me-encode file dalam antri satu demi satu. Editor dapat

menambahkan file ke antrian setelah encoding dimulai. Bahkan dapat

menambahkan file ke antrian langsung dari Premiere Pro saat pengkodean

sedang berlangsung.

• Meubah pengaturan: Setelah tugas pengkodean dimuat ke queue, mengubah

pengaturan menjadi mudah; klik item Format atau Preset, dan dialog

Pengaturan Ekspor muncul.
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7.4. Latihan soal dan jawaban

Soal

1. Bagaimana cara untuk export single frame?

2. Bagaimana cara menyatukan seluruh editing pada timeline panel

supaya menjadi satu kesatuan video?

3. Apa yang harus diperhatikan dalam melakukan pengaturan pada

menu export media?

4. Apa format encoding yang harus digunakan saat mengexport ke

berbagai perangkat seluler?

5. Apakah harus menunggu Adobe Media Encoder selesai proses render

queue sebelum memulai berkerja projek baru di Premiere Pro?

Jawaban

1. Dengan menekan tombol atau menggunakan shortcut

Shift+Control+E (Windows) atau Shift+E (Mac OS) pada keyboard.

2. Export media dapat dilakukan dengan memilih menu File > Export >

Media. Atau dengan menggunakan shortcut Control+M (pada

Windows) atau Command+M (Pada Mac).

3. Memeriksa hasil akhir tujuan video yang diharapkan, dimensi, frame

rate, juga kualitas audio yang dibutuhkan.

4. H.264 adalah format encoding yang digunakan saat mengexport ke

sebagian perangkat seluler.

5. Tidak. Adobe Media Encoder adalah aplikasi yang berdiri sendiri.

Selain itu dapat bekerja dengan aplikasi lain atau bahkan memulai

projek yang baru di Premiere Pro saat proses render queue

berlangsung.
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BAB VIII

PENGENALAN AFTER EFFECT

Tujuan Pembelajaran Umum

 Mahasiswa mampu memahami Adobe After Effect CC 2015 sebagai

salah satu software motion graphic dan animasi.

Tujuan Pembelajaran Khusus

Pembelajaran pada bab ini bertujuan untuk:

 Mampu mengenal bermacam-macam tool pada tampilan interface

adobe after effect cc 2015.

 Mampu memahami fungsi tool serta mengoprasikan tool pada adobe

aftter effect CC 2015.

 Mampu menciptakan new compositing dalam adobe after effect

hingga menciptakan pergerakan animasi.

 Mampu memahami proses pembuatan tracking kamera dan tracking

motion untuk opening video.
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Halo editor handal indonesia. Salam kreatif dan Salam Budaya.

Terima kasih sudah menyempatkan diri untuk mencoba belajar

mencintai produksi audio visual. Kali ini kita akan mempelajari tahapan

terakhir dalam produksi audio visual atau film yang perlu diketahui ada tiga

tahap dalam produksi audio visual (pra produksi, produksi, dan pasca

produksi). Pada proses terakhir ini (pasca produksi) menjadi tahapan yang

menetukan karena penggabungan alur yang sudah disusun menjadi naskah

ditentukan disini. Ibarat bermain sepak bola akankah striker memasukan bola

kegawang atau tendangan melenceng keluar gawang.

Adobe affter effect merupakan salah satu software yang berada dalam

kumpulan keluarga besar adobe seperti (adobe premiere, adobe audition,

adobe affter effect, adobe flash, adobe xd, adobe photo shop dll) sebagai

seorang editor pasti mengenal salah satu software adobe minimal pernah

mendengar. Seperti yang kita lihat bersama pada stasiun televisi, iklan, vlog

hingga film rata-rata menggunakan adobe affter effect sebagai unsur

tambahan agar unsur dramatik yang sudah diciptakan pada naskah dapat

diterpakan pada video tersebut agar pesan yang ingin disampaikan dapat

diterima penonton dengan baik, selain dramatik dapat tercipta kesan elegan

tercipta dalam tayangan tersebut.

Fungsi adobe after effect sangat perlu sekali dimunculkan karena hal ini

akan menaikan kualitas dari tayangan tersebut. Pada generasi 4.0 ini seorang

editor wajib memiliki kemampuan tambahan dalam mengoperasikan adobe

affter effect, karena dalam kempuan mengedit sebuah tayangan editing saja

tidaklah cukup dalam mengemas sebuah tayangan video. Agar dalam

pengoperasian adobe affter effect tidak mengalami kendala teknis penulis

menyarankan komputer atau laptop harus memenuhi batas minimun terlebih

teman-teman memilih adobe affter effect CC 2015. Untuk spesifikasi

minimun agar software adobe affter effect dapat beroprasi dengan baik
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penulis menyarankan minimal (Intel processor setara I 3, Memory RAM 2

giga, VGA 3000 amd).

Pada tahap editing video hingga affter effect ini penulis menganggap

bahwa temanteman sekalian sudah mengerti dan paham 2 tahap sebelumnya

yaitu pra produksi dan produksi serta menghasilkan video yang siap untuk

diedit. Harapan penulis teman-teman dengan modulini semakin mengenal cara

mengedit hingga membuat effect dengan benar agar hasil video dapat diterima

penonton dengan baik serta mendapat repon yang positif. Modul ini akan

sangat berguna sekali jika teman-teman sering melakukan proses editing

video serta berdiskusi sesama editor, agar menemukan trik baru dalam proses

pasca produksi.

8.1 Mengenal tampilan Adobe Affter Effect

Adobe affter effect adalah sebuah program penyunting video berbasis

non-linier (nonlinear editor / NLE) dari Adobe Systems. Adobe affter

effect adalah salah satu produk software dari Adobe Creative Suite.

Software ini merupakan software pengolah video dengan interface yang

cukup mudah. Saat awal kita membuka Adobe affter effect kita akan

diberikan beberapa opsi seperti berikut.
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Gambar 8.1Mengenal Tampilan pembuka After Effect

a. New Composition digunakan untuk membuat projek baru.

b. Open Projek dipilih untuk melanjutkan projek yang sudah kita

kerjakan.

8.2 Mengenal Tampilan Bar After Effect

Berikut adalah tampilan saat kita memilih membuat projek baru.

Berbeda dengan adobe photoshop atau illustrator, Adobe affter effect

mengharuskan kamu untuk menyimpan projeknya terlebih dulu. Secara

default Adobe affter effect akan memilihkan lokasi penyimpanan

default, namun kita bisa mengganti lokasi penyimpanan dengan

menekan “Browse” dan pilih lokasi yang diinginkan. Kamu juga bisa

memberi nama projekmu di bagian “Name”. Setelah selesai klik “Ok”.

Gambar 8.2Mengenal Tampilan Bar After Effect

1. MenuBar: Kumpulan menu yang mengakses fitur secara garis besar.

2. ToolBar: Berisi peralatan yang siap membantu dalam mengedit.

3. Libary Effect: Tempat effect berada.

4. Libary Project: Kumpulan project.

5. Detail effect and layer: Tempat mengatur video.
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6. TimeLine:Menampilkan durasi pada video.

7. Plate. Pengaturan effect yang akan diedit.

8. Menu tambahan: Untuk mencari effect layout sesuai kebutuhan.

9. Info: Memberikan tampilan informasi sumbu dan warna effect.

10. Composition: Lembar kerja kita.

Setelah kita mengetahui tampilan awal pada after effect sekarang kita

mempelajari apa saja yang terdapat dalam bar dan fungsi dari setiap bagian.

8.3 ToolBar

Berisi peralatan yang siap membantu dalam mengedit.

8.4 Libary Project:

Tempat effect berada serta kumpulan project.

Gambar 8.4 Tampilan Libary
Project
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a. Fungsi Libary Effect: Tempat effect berada.

b. Fungsi Libary Project: Kumpulan project.

8.5 Detail Effect dan TimeLine

Tempat mengatur video dan Menampilkan durasi pada Video.

Gambar 8.5 Tampilan Detail Effect dan TimeLine Toolbar.

a. Fungsi Detail effect and layer: Tempat mengatur video.

b. Fungsi TimeLine:Menampilkan durasi pada Video.

8.6 Menu Tambahan dan Plate:

Untuk mencari effect layout sesuai kebutuhan dan Pengaturan effect

yang akan diedit.
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Gambar 8.6 Tampilan Menu Tambahan

a. Fungsi Menu Tambahan: Untuk mencari layout sesuai kebutuhan.

b. Fungsi Plate. Pengaturan effect yang akan diedit.

8.7 Composition Pada After Effect

Composition Adalah meja kerja dalam membuat effect dimana seorang

editor akan menggabungkan effect yang sudah direncanakan dalam naskah

dengan Materi yang berasal dari proses perekaman melalui kamera film atau

kamera video yang biasa disebut footage.

Pada tampilan awal after effect seorang editor akan melihat puluhan

hingga ratusan panel dan tools dalam After Effect. Pada tahap awal ini

seorang editor diwajibkan membuat meja kerja atau membuat New

Composition terlebih dahulu, agar panel dan tools yang terdapat pada jendela

kerja menjadi aktif dan dapat digunakan. Untuk mengatur setting

Composition pada kotak dialog Compositions Settings. Dalam

mempersiapkan meja kerja compostion apa saja yang perlu diperhatikan.
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a) Cek kembali effect apa saja yang dibutuhkan sesuaikan dengan

naskah.

b) Pastikan terlebih dahulu pixel aspect ratio footage yang sedang

dikerjakan.

c) Silahkan siapkan footage potong video tersebut sesuaikan dengan

kebutuhan effect maksimal durasi 30 Detik.

Untuk tahap awal ini seorang editor wajib melakukan dengan tepat,

karena kesuksesan dalam pembuatan effect tergantung dari awal langkah

mempersiapkan footage hingga menentukan meja kerja yang tepat. Hal ini

menjadi pondasi awal editor agar dalam tahap penambahan effect pada

footage tidak mengalami hambatan teknis pada komputer atau laptop yang

digunakan.

Gambar 8.7. Tampilan Awal Pada Saat Membuat Composition

8.8 Menentukan Aspect Ratio

Pastikan terlebih dahulu pixel aspect ratio footage yang sedang

dikerjakan Sebagai seorang editor (empat) langkah awal inilah menentukan

pixel aspect ratio yang wajib diperhatikan agar dalam pengerjaan pemberian
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effect tidak menemukan hambatan seperti laptop yang bekerja sangat panas,

sering blue screan, laptop sangat berat bekerja, hingga distorsi resolusi apabila

tidak diperhatikan dengan tepat.

Gambar 8.8.Menyamakan Footage Dengan Composition

a) Periksa kembali footage apakah sesuai dengan

composition.

b) Perhatikan frame width wajib disamakan (contoh 1280).

c) Perhatikan frame height wajib disamakan (contoh 720).

d) Perhatikan frame rate 23 frames/second.

Setelah semua sesuai antara footage dan compotion tentukan berapa

durasi yang akan digunakan dalam pemberian effect, Silahkan siapkan footage

potong video tersebut sesuaikan dengan kebutuhan effect

8.9 Menentukan Durasi Pada Composition

Bagaimana jika produser atau sutradara menginginkan waktu lebih dari

30 detik semisal 60 detik effect sesuai dalam naskah. Kembali lagi sebagai

seorang editor kita wajib melihat kembali kemampuan komputer atau laptop

editor, jika komputer yang dimiliki mempunyai kapasitas ram rendah dibawah
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6 giga disarankan untuk memisah project affter effect menjadi 2 bagian.

Project after effect A 30 detik, After effect B 30 detik kemudian jika project

sudah selesai silahkan gabung project tersebut pada software adobe premiere

maksimal durasi 30 Detik.

Gambar 8.9Menentukan Durasi Pada Composition

8.10 Membuat Composition

Perhatikan langkah-langkah membuat composition.

a) KlikMenu Composition.

b) New Composition atau klik tombol Create a New Composition

pada Project.
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Gambar 8.10 Tampilan Menu Composition

a) Pada kotak dialog Composition Settings, ketik nama Composition

yang akan dibuat di bagian Composition Name.

Gambar 8.11 Composition Name
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b) Atur format video yang akan dikerjakan pada Tabulasi Basic.

Gambar 8.12 Format Video

c) Preset berisikan berbagai macam preset format video.

Gambar 8.13 Preset

d) Width dan Height untuk mengatur ukuran frame video secara

manual.

Gambar 8.14Width dan Height

e) Pixel Aspect Ratio berisikan pilihan format Aspect Ratio video

yang akan digunakan.

Gambar 8.15 Pixel Aspect Ratio

f) Frame Rate berisi nilai frame dengan satuan frame per detik (fps).

Gambar 8.16 Frame Rate

g) Resolution untuk menentukan resolusi gambar yang dihasilkan.

Gambar 8.17 Resolution
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h) Start Timecode untuk menentukan nilai timecode awal.

Gambar 8.18 Start Timecode

i) Duration untuk menentukan durasi video yang akan dibuat pada

timeline.

Gambar 8.19 Duration

j) Background Color untuk menentukan warna background yang

akan digunakan.

Gambar 8.20 Tampilan Keseluruhan Composition Settings

k) Klik OK untuk mengakhiri perintah.
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BAB IX

BEKERJA DENGAN TIMELINE

Tujuan Pembelajaran Umum

 Mahasiswa mampu memahami Timeline adobe after

effect agar bisa menentukan durasi pada footage

Tujuan Pembelajaran Khusus

Pembelajaran pada bab ini bertujuan untuk:

 Mampu membuat text dengan benar serta mengatur

efek pada text.
 Mampu merubah type text, font hingga paragaf text.

 Mampu memahami cara bekerja dengan layer footage.

 Mampu membuat animasi Text dengan

memaksimalkan menu Tracker Camera.
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9.1 Bekerja Dengan Timeline

Bagi editor adobe premiere sangat tidak asing dengan istilah

timeline. Time line adalah tempat menyusun footage yang akan di

gunakan untuk memberikan effect tertentu juga sebagai penanda waktu

pada detik keberapa animasi dimulai dan berakhir. Nantinya susunan

footage pada timelane akan di tampilkan pada panel composition oleh

sebab itu seorang editor wajib mengetahui cara memotong durasi,

merubah nama agar tidak lupa atau tertukar saat memberikan effect.

Gambar 9.1 Tampilan Timeline Belum Dipotong Sesuai Durasi Dan

Nama Auto Text

9.2 Menghapus Durasi Text

Seperti kasus pada contoh diatas kita bisa melihat bahwa text

melebihi durasi sesuai ketentuan. Hal ini bisa mempengaruhi saat

render video dan menentukan durasi akhir dari effect yang akan

dirender. Untuk itu editor perlu mengetahui cara memotong durasi dan

membuang durasi yang tidak terpakai.

a) Klik tombol Selection Tool.

Gambar 9.2 Tombol Selection Tool
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b) Atur posisiWork Area start danWork Area End.

Gambar 9.3 Tombol Work Area

c) Pilih Layer yang akan dipotong.

Gambar 9.4 Tampilan Layer

d) Gunakan tombol ( ] ) pada keyboard silahkan cari sekitar enter.

Gambar 9.5 Tampilan Layer Sesudah Dipotong

e) Jika menginginkan bagian depan yang ingin dipotong gunakan

tombol ( [ ) silahkan cari sekitar enter.

9.3 Bekerja Dengan Layer

Selanjutnya kita perlu mengetahui apa yang dimaksud dengan

layer, Layer merupakan komponen yang mengisi composition , layer

dapat dibentuk dengan menempatkan footage video,effect kedalam

timeline dalam. Layer juga sebagai penanda file apa yang sedang kita

pilih dan kita kerjakan. Layer dalam adobe after effect berada dipojok

kiri berdampingan dengan timeline. Sebagai seorangan editor kita perlu
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mengetahui poject mana yang sedang kita kerjakan untuk diberikan

effect tertentu. Agar footage yang kita kerjakan tidak tertukar dengan

project lainnya perlu kita pelajari bagaimana cara memberi label

footage tersebut.

a) Klik tombol Selection Tool.

Gambar 9.6 Tampilan Selection Tool

b) Klik kolom Source Name pada panel Timeline untuk

mengubahnya menjadi Layer Name.

c)

Gambar 9.7 Tampilan Panel Timeline

d) Pilih Layer yang akan di ganti namanya. Tekan Enter pada

keyboard untuk mulai mengganti nama layer.

Gambar 9.8 Tampilan Jika Nama Sudah Berganti
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e) Ketikkan nama Layer baru.

f) Tekan Enter pada keyboard untuk mengakhiri.

9.4 Bekerja Dengan Teks After Effect

Pada bab yang ke 2 ini kita mempelajari teknik membuat teks

pada after effect, pada dunia industri televisi maupun film kemampuan

editor untuk membuat teks animasi sangat diperlukan. Hal ini menjadi

kemampuan standart karena seorang editor harus bisa membuat bumper

in juga bumper out pada program video yang sedang dikerjakan. After

effect salah satu program animasi populer di industri audio visual

karena masuk dalam keluarga Adobe Creative Suite sehingga seorang

editor dapat mempelajari tool dengan cepat pada tampilan affter effect.

Dalam Adobe After Effect CC 2015-2020 sekarang ini layer

mampu membuat animasi dengan mudah. Pada modul ini kita akan

mempelajari bagaimana menganimasikan teks menggunakan fasilitas

tool teks camera dan trakcker motion pada Adobe After Effect CC 2015.

Sebelum kita mempelajari animasi teks editor harus mengetahui

bagaimana mengatur dan memahami fungsi dari layer teks pada

tampilan adobe after effect.

Layer teks merupakan layer sintetis yang berarti bahwa layer ini

tidak menggunakan footage sebagai sumbernya. Layer ini merupakan

layer vektor yang sama seperti shape layer dan juga layer vektor yang

lain, jadi apabila layer tersebut akan dibesarkan atau dikecilkan gambar

akan terlihat dengan jelas tidak pecah karena Effects distorsi. Editor
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dapat mengedit teks tersebut secara langsung pada panel composition

dan menggunkan font yang tersedia pada affter effect.

Gambar 9.10 Tampilan Compotion Setings

a. New Composition digunakan untuk membuat projek baru

teks.

b. Ok untuk melanjutkan projek pembuatan teks.

Untuk membuat text ingat kembali simbol text yang sudah kita

pelajari pada materi sebelumnya. Pada toolbar bisa kita lihat ada

sombol huruf (T)

Gambar 9.11 Tampilan Toolbar
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9.5 Memasukan Text

Dalam Proses pengaturan format karakter, panel yang digunakan

adalah panel Character. Pengaturan pada panel Character ini hanya

berpengaruh pada karakter yang diseleksi saja. Silahkan ikuti langkah

seperti berikut.

a) Klik huruf T dan masukan huruf contoh (abcdefg).

b) Seleksi Pen Tool kemudian geser tulisan tersebut sesuai

tempat yang diinginkan.

Setelah editor memilih tempat yang sesuai saatnya setting paragaf,

style font, warna, ukuran font dan seterusnya ikuti langkah-langkah

dibawah ini.

Gambar 9.12 Contoh Final Input Text Beserta Line

9.11 Menampilkan Panel Character

a) Klik menu Window - Character, atau pada saat aktif

dengan menggunakan Type Tool.

b) Maka klik tombol Toggle The Character and Paragraph

Panel yang tampil pada panel Tools.
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Gambar 9.13 Tampilan Seting Paragaf

9.6 Mengatur Font

Tombol Faux Style berguna mensimulasikan style font. Faux

Style berada di bagian bawah panel Character. Untuk memilih

font family, gunakan salah satu langkah berikut

a) Klik pada bagian Font Family Menu Box, kemudian ketikkan

huruf pertama dari nama font family yang akan dipakai.

b) Fill dan Strok pada Panel Character.

Gambar 9.14 Tampilan Seting Font
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9.7 Langkah Untuk Menambahkan Stroke Ke Dalam Teks

a) Pilih karakter yang akan diwarna Stroke.

b) Atur ketebalan stroke pada properti Stroke Width Pada Panel

Character.

c) Pilih warna stroke dengan cara klik dua kali pada kotak

pengaturan warna stroke,

kemudian pilih warnanya dalam kotak dialog Text Color.

d) Pilih salah satu jenis tampilan stroke dengan cara klik pada

tombol pop up menu

Stroke Options.

Gambar 9.15Merubah Warna

9.12 Kerning dan Tracking

Kerning adalah proses penambahan atau pengurangan jarak pada

sepasang huruf. Sedangkan Tracking adalah proses pengaturan untuk

menentukan jarak pada setiap hurufnya. Kerning dapat dilakukan

secara otomatis dengan menggunakan
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a) Metrics Kerning digunakan untuk mengatur jarak pada

pasangan huruf yang telah ditentukan yaitu, La, To, Tr, Tu,

Ty, WA, We, Wo, Ya, dan Yo, secara default

b) Optical Kerning, pasangan huruf yang akan diatur jaraknya,

adalah pasangan huruf yang posisinya sangat berdekatan.

Gambar 9.16 Kerning dan Tracking

9.13 Scale dan Baseline Shift

a) Horizontal Scale dan Vertical Scale berfungsi untuk

menentukan pemakaian panjang dan lebar teks.

b) Baseline Shift digunakan untuk mengatur jarak antara teks

yang dihasilkan terhadap garis dasar.

c) Untuk mengatur skala, masukan nilai presentasi baru pada

Horizontally Scale atau Vertically Scale, atau klik tahan

dan geser nilai yang bergaris bawah pada panel Character.

Kerning
Tracking
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d) Sedangkan untuk mengatur Baseline Shift, atur nilai yang

ada pada Baseline Shift pada Panel Character.

Gambar 9.17 Scale dan Baseline Shift

9.14 Mengatur Format Paragaf

a) Menuju bounding Box Paragaf.

b) KlikMenu.

c) KlikWindow.

d) Seting Paragaf.

Gambar 9.18 Tampilan Format Paragaf

Vertical
Horizontal
Scale

Baseline



TEKNIK PENYUNTINGAN DIGITAL

101

9.17 Bekerja Dengan Teks Tracker Camera
Pada pembukaan opening film atau video cinematic kebanyakan

menggunakan camara drown untuk menghasilkan gambar landscape

untuk memperkenalkan lokasi dari film tersebut, dan hal inilah

dimanfaatkan editor dalam video tersebut menambahkan effect opening

menggunakan teks. Pada perkembangan after effect text tersebut bisa

ditampilkan secara 3 dimensi yang seolah-olah text tersebut menempel

pada lokasi tersebut. Tidak Cuma itu saja nama sutradara artis hingga

crew juga sering sekali nampak pada opening text menggunakan angle

drown.

Gambar 9.19 Opening Menggunakan Text Tracker Camera

Sebelum memberikan effect tracker camera pada footage perlu

menjadi pertimbangan editor agar memastikan footage yang dipilih

durasi tidak lebih dari 15 detik, dipilih footage drown dalam keadaan

terbang stabil, kontras warna dalam footage sangat baik. Kenapa hal ini
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dilakukan karena tracker kamera akan menganalisis dari pergerakan

kamera hingga warna, untuk lebih jelasnya ikuti perintah dibawah ini.

9.18 Membuat Composition

a) Buatlah Composition baru.

b) Sesuaikan durasi dengan kemampuan PC/ Laptop.

c) Periksa kembali resolusi footage yang akan diedit.

d) Pastikan Frame Rate pada Composition sama dengan

footage.

e) Klik OK.

Gambar 9.19Membuat Composition Baru

9.19 Tracker Camera

a. Silahkan periksa pada kolom menu tambahan pojok kanan

bawah.

b. Jika tidak ada Tracker aktifkan memalui window klik dan cari

Tracker.
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c. Setelah Tracker berada diposisi kolom tambahan.

d. Klik footage dan aktifkan Track Kamera.

e. Affter effect akan bekerja tunggu hingga muncul perintah

selanjutnya.

Gambar 9.20 Tampilan Analyzing Background

9.20 Solving Camera

a. Solving Camera merupakan tanda bahwa proses analyzing

selesai.

b. Jika tidak keluar tanda x berwarna-warni atau titik Point Text.

c. Silahkan klik Layer footage d. Kemudian klik Effect.
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Gambar 2.2.4 Tampilan Solving Camera

9.21 Menentukan Titik Create Text and Camera

a. Tampilan akan berubah menjadi garis X warna-warni.

b. Kemudian pilih titik dimana lokasi text.

c. Tekan Space Bar untuk mencari lokasi titik sesuai keinginan.

d. Jika sudah terpilih klik titik X.

e. Kemudian klik kanan.

f. Pilih Create Text and Camera.

Gambar 9.21Menentukan Titik Text
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9.22 Insert Text

a. Untuk menampilkan text tekan T pada kolom tool di atas.

b. Ketik text sesuai keinginan

c. Setting font sesuai materi sebelumnya.

d. Cek kembali apakah sesuai dengan keinginan dengan

menjalankan video.

e. Jika ok tahap terakhir Render.

Gambar 9.22 Contoh Text Tampilan Tracker Kamera
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BAB X

Bekerja Dengan Camera Motion

Tujuan Pembelajaran Umum

 Mampu memahami animasi text dengan memaksimalkan camera

motion pada adobe after effect.

Tujuan Pembelajaran Khusus

 Mampu bekerja dengan Track Motion agar membantu penonton

mengerti pesan yang disampaikan pada film atau video.

 Mampu memahami fungsi Effects pada adobe after effect CC

2015.

 Mampu memahami cara bekerja dengan Presets dan fasilitas efek

yang terdapat pada adobe after effect.
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10.1 Bekerja Dengan Camera motion

Pada menu track dibagi menjadi 4 bagian untuk yang sudah kita

pelajari bersama tracker camera dimana objek 2 d dibuat seolah-olah

memiliki text berbentuk 3 dimensi sehingga tulisan tersebut menempel

pada titik yang kita inginkan. Namun dalam fasilitas yang dimiliki affter

effect cc 2015 tidak hanya track kamera saja. Editor perlu memahami

fasilitas lain seperti stabilzer kamera dan track motion. Sebagai

pengetahuan stabilizer kamera sama persis dengan fasilitas yang dimiliki

adobe premiere dimana jika kameramen dalam pengambilan gambar

terjadi tremor atau kamera bergetar maka fasilitas ini bisa digunakan.

Gambar 10.1 Contoh Text Tampilan Tracker Motion

Kemudian jika kita amati kembali terdapat camera motion, mungkin

beberapa editor sudah pernah melihat tayangan televisi atau film dimana

terdapat footage bahwa aktor sedang melihat gadget hand phone maupun

tablet. Namun penonton akan kesulitan menerima pesan apa yang dilihat

aktor tersebut. Hal ini menjadi penting karena pesan tersebut akan

berhubungan langsung dengan scene atau adegan selanjutnya. Adobe after
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effect melihat kebutuhan tersebut dan memberikan fasilitas camera motion.

Silahkan editor mengikuti petunjuk dibawah ini

10.2 Membuat Composition

a) Buatlah Composition baru.

b) Sesuaikan durasi dengan kemampuan PC/ Laptop.

c) Periksa kembali resolusi footage yang akan diedit.

d) Pastikan frame rate komposition sama dengan footage.

e) Klik OK.

Gambar 10.2 New Compotision

10.3 Memasukan Footage dan Memasukkan Tracker Motion

a) Masukan footage yang sudah disiapkan sesuaikan dengan durasi

Composition.

b) Silahkan periksa pada kolom menu tambahan pojok kanan

bawah.

c) Jika tidak ada tracker aktifkan memalui window klik dan cari

Tracker.

d) Setelah Tracker berada diposisi kolom tambahan.
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e) Klik footage dan aktifkan Track Kamera.

f) Affter effect akan bekerja tunggu hingga muncul perintah

selanjutnya.

Gambar 10.2Memasukkan Tracker Motion

10.3. Memulai Track Motion

a) Klik Track Point 1 tahan dan geser ketitik yang direncankan.

b) Cari Analyzing diarea Tracker.

c) Jika tidak terlihat silahkan perlebar kolom Tracker.

d) Tekan Play dan proses Analyzing.
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Gambar 10.3Mengaktifkan Tracker Motion

10.4 Menentukan Null Objet

a) Null Object merupakan penghubung atau jembatan antara

analyze dengan text 26.

b) Klik Edit Target kemudian tentukan point ke Null.

c) Klik OK.

Gambar 10.4Mengaktifkan Null Object
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10.5. Apply Dimension

a) Klik Apply.

b) Kemudian pilih x dan y.

c) Klik OK.

Gambar 10.5 Apply Dimension

10.6. Memasukan Text Video

a) Setelah Null berubah warna dari biru kemerah tanda Null siap

dihubungkan ke text.

b) Masukan footage video.

c) Video berisi komunikasi aktor yang direkam oleh screan recorder

hand phone.

d) Atur posisi skala video dengan cara mengecilkan project monitor

menjadi 25 %.
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Gambar 10.6Memasukan Text Video

10.7. Menghubungkan Text Video Dengan Null

a) Tahap terakhir hubungkan text ke Null.

b) Perhatikan pada layer footage.

c) Rubah None dengan klik Null.

d) Cek kembali video apakah sesuai dengan keinginan dengan

menjalankan video.

e) Jika ok tahap terakhir Render.

Gambar 10.7 Tampilan Hasil Motion Tracking
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10.8 Membuat Bumper Frezee

Seperti yang kita ketahui bersama bumper in dalam sebuah tayangan

video merupakan pengenalan awal atau yang biasa disebut golden hours,

seorang editor harus membuat semenarik mungkin agar penonton memiliki

minat untuk mengikuti setiap adegan pada video tersebut. Selain

pengenalan karakter melalui bumper in kita juga memberi Effects khusus

agar video atau film kita berbeda lain dari yang lain. Bumper Frezee

merupakan alternatif yang perlu dicoba karena dengan Effects khusus

tersebut editor bisa memberhentikan durasi dan memberikan Effects

warna, Effects masking, Effects cartoon, Effects distorsi dan berbagai

macam teknik yang lain sesuai imajinasi editor dalam memaksimalkan

bumper in.

Untuk mengaktifkan Frezee dalam affter effect kita perlu memahami

logika dari freezing bukan menghafal. Frezee dalam pengertian Indonesia

adalah memberhentikan dan apa yang diberhentikan adalah waktu atau

scene kita inginkan. Scene merupakan kumpulan dari shot serta didalam

shot terdapat ratusan hingga ribuan frame. Frezee pada affter effect

merupakan teknik memilih 1 frame kemudian dilanjutkan duplikat 1 frame

menjadi video berdurasi semisal 5 detik.

Gambar 10.8 Tampilan Hasil Bumper Frezee
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Pada contoh kita perlu mempersiapkan footage terlebih dahulu

kemudian membuat gambar dari photoshop atau download brush Effects

dalam format PNG. Untuk menghasilkan seperti contoh gambar silahkan

editor mengikuti petunjuk dibawah ini

10.9 Membuat Composition

a) Buatlah Composition baru.

b) Sesuaikan durasi dengan kemampuan PC/ Laptop.

c) Periksa kembali Resolusi Footage yang akan diedit.

d) Pastikan Frame Rate komposition sama dengan footage.

e) Klik OK.

Gambar 10.9 New Composition

10.10 Memasukan Footage dan Duplikat Footage

a) Masukan footage yang sudah disiapkan sesuaikan dengan durasi

Composition.

b) Duplikasi dengan cara tekan Shift+D pada keyboard.

c) Cara kedua padaMenu Bar klik edit.
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d) Scroll down mouse klik Duplicate.

Gambar 10.10 Duplikat Footage

10.11. Frezee Time

a) Play dan berhentikan pada durasi yang diinginkan.

b) Klik kanan mouse.

c) Pilih Time.

d) Klik Frezee Frame.

Gambar 10.11 Frezee Time
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10.12 Memotong Durasi Dengan Split Layer

a) Klik footage yang akan dipotong.

b) Blok footage cara tekan Ctrl+Shift+D pada keyboard.

c) Kedua padaMenu Bar klik edit.

d) Scroll down mouse klik Split Layer.

Gambar 10.12 Hasil Tampilan Split Layer

10.13 Menggabungkan Video Dengan Frezee Time

a) Play video.

b) Pisahkan video.

c) Beri jarak sehingga Video Play + Frezee + Play.

d) Koreksi kembali
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Gambar 10.13 Hasil Tampilan Dengan Frezee Time

10.14 Memberikan Warna Pada Background

a) Pilih footage.

b) Pada kolom Plate sebelah kanan.

c) Masukan Effect Tint.

d) Warna sesuai keinginan.

Gambar 3.1.5 Hasil Tampilan Perubahan Warna Background
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10.15 Memisahkan Object Dengan Background

a) Klik footage yang akan di Pen.

b) Klik tombol Pen Tool atau tekan (G).

c) Add Anchor Point secara perlahan pada area objek.

Gambar 10.15 Hasil Tampilan Memsisahkan Objek Dengan

Background

10.16 Duplicate Background

a) Setelah background terpisah.

b) Duplicate 4 kali.

c) Masukan Effects Shadow Highlight.

d) Masukan Unshrap Mask.

e) Masukan Stroke.

f) Masukan Cartoon.
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Gambar 10.16 Duplicate Background

10.17 Insert Text Dan Effects Brush

a) Siapkan 4 Effects brush png.

b) Atur Effects warna brush sesuai keinginan.

c) Posisikan pada tempat yang diinginkan.

d) Atur Transform, Size, animasi brush pada kolom Detail Effect

dan Layer

e) Insert text.

f) Atur durasi muncul dan hilangnya text pada kolom Time Line.

Gambar 10.17 Hasil Akhir Bumper Frezee dan Text
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BAB XI

Membuat Effect Dan Presets

Tujuan Pembelajaran Umum

 Mampu memahami fungsi effects presets serta merubah video sesuai

efek yang diberikan dan audio efek pada adobe after effect.

Tujuan Pembelajaran Khusus

 Mampu memahami fungsi Effects Dan Presets pada adobe after effect

CC 2015.

 Mampu memahami cara bekerja dengan Effects Audio dan berbagai

fasilitas efek yang terdapat pada adobe after effect

 Mampu memahami cara bekerja katagori 3D chanel

 Mampu memahami cara bekerja preset serta perbedaan tampilan

macam-macam preset dalam adobe after effect CC 2015
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11.1 Membuat Effects Dan Presets

Sebelum membuat logo png yang dijadikan bumpper in atau

menambahkan effect dalam project after effect agar menimbulkan kesan lebih

menarik lagi maka editor wajib mengenali dan mengerti bukan menghafal apa

itu effect dan presets. Apa itu effects dan presets dan apa fungsinya, effects

presets merupakan kumpulan Effects yang sudah tersimpan sehingga kita bisa

menggunakannya secara mudah, hanya dengan mengklik atau mendrag

Effects tersebut, maka Effects tersebut sudah bisa dijalankan, jadi kita tidak

harus membuat Effects secara manual.

Adobe after effect juga memiliki Effects yang dapat ditambahkan

kedalam sebuah layer untuk memperkuat karakteristiknya, panel effect dan

presets merupakan tempat tersimpannya berbbagai macam Effects . Setiap

ikon yang ada disebelah kiri nama Effects menunjukan jenis dan kegunaan

dari Effects itu sendiri. Dalam perkembangan adobe after effect khususnya

adobe after effest CC 2015 sudah memiliki berbagai macam Effects audio hal

ini dilakukan agar editor tidak perlu menginstal adobe audition dan

mempelajari tools didalam software adobe audition. Tentu saja perkembangan

software adobe after effect ini akan mempermudah kerja editor membuat

Effects visual juga Effects audio dalam membuat program televisi maupun

film.

11.1 Membuat Composition

a) Buatlah Composition baru.

b) Sesuaikan durasi dengan kemampuan PC/ Laptop.

c) Periksa kembali resolusi footage yang akan diedit.

d) Pastikan frame rate komposition sama dengan footage.

e) Klik OK.
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Gambar 11.1 New Composition

11.2 Mengetahui Posisi Effect dan Presets

a) Posisi Effect dan Presets terletak di bagian menu.

b) Window kemudian pilih Effect & Presets.

c) Klik kanan pada footge di Detail effect and layer.

d) Klik Effect.

e) Pada area menu tambahan sebelah kanan.

f) Geser menggunakan mouse Klik Effect.



TEKNIK PENYUNTINGAN DIGITAL

123

Gambar 11.2 Tampilan Efects dan Presets

11.3 Memasukkan Effects dan Presets Ke Dalam Layer

a) Untuk memasukkan hanya perlu geser Effects & Presets ke dalam

layer.

b) Untuk memasukkan Effects & Presets animasi ke dalam layer,

klik 2 kali Effects pada panel Effects & Presets dan pilih Effects

yang diinginkan.

c) Untuk memasukkan preset yang terakhir digunakan, pilih layer

klik menu Animation Recent Animation Presets.

d) Untuk menyalin Effects ke layer yang lain klik menu Edit Copy

kemudian klik menu Edit di layer yang akan di beri Effects.
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11.4 Menghapus Serta Menghilangkan Effects dan Presets

a) Untuk menghapus Effects & Presets.

b) Pilih Effects pada Effect Controls, tekan Delete.

c) Untuk menghapus semua Effects pada layer, pilih layer Timeline

atau Composition.

d) klik menu EffectRemove All.

11.5 Membuat Presets Animasi

a. Plilih semua properti yang telah di animasikan.

b. Klik menu Animation Save Animation Presets.

Gambar 11.3 Tampilan Presets Animasi

11.6 Effects Audio

Mengingat pentingnya audio untuk memperkuat bahasa gambar

dalam sebuah animasi, adobe after effects juga menyediakan berbagai jenis

Effects audio yang dapat digunakan untuk menyempurnakan audio sebagai

effects dan juga musik latar. Adobe After Effects juga menyediakan berbagai

jenis Effects audio yang dapat digunakan untuk menyempurnakan audio

sebagai sound effects dan musik latar.
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Di dalam Effects audio tersebut terdapat berbagaimacam kategori Effects di

dalamnya antara lain:

Backwards, Bass & Trable, Delay, Flange &Chorus, High-Low Pass,

Modulator, Parametric EQ, Reverb Stereo Mixer, Tone

Gambar 11.4 Tampilan Effects dan Presets Audio

a) Backwards

Effects ini digunakan untuk membalik suara dari sebuah layer dengan

menjalankannya dari akhir ke awal. Berbeda dengan time-reverse,

dengan menggunakan Effects ini frame yang ada pada chanel time line

tidak berubah
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b) Bass & trable

Effects ini dapat digunakan untuk menambah atau mengurangi

frekuensi bass dan trable pada audio. Namun control yang pada Effects

ini sangat sederhana. Apabila anda menginginkan pengaturan yang

lebih detail, gunakan parameter EQ

c) Delay

Effects delay ini berfungsi untuk mensimulasikan suara bayangan atau

pantulan seperti gema. Dengan Effects ini editor juga dapat

menentukan jumlah suara yang dihasilkan dengan properti delay

amount.

d) Flange & Chorus

Flange adalah Effects audio yang digunakan untuk menghasilkan suara

yang terkesan rengkap tetapi jumlahnya berubah-ubah setiap waktu,

sedangkan chorus digunakan untuk menghasilkan suara yang terkesan

rangkap saja sehingga audio yang diberi Effects ini akan terdengar

seperti dibunyikan dengan jumlah yang banyak.

e) High-low & Pas

Effects high-low & pas ini akan membatasi yang ada diatas atau

dibawahnya. High pass akan membuat audio dengan frekuensi tinggi

tertutup.

f) Modelator

Effects ini akan membuat vibrata dan tremolo kedalam audio sehingga

menghasilkan suara yang bergetar.

g) Paramatic EQ

Dalam Effects ini terdapat sejumlah pengaturan frekuensi yang lebih

spesifik.
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h) Reverb

Effects ini mensimulasikan pantulan suara seperti yang dihasilkan oleh

suara.

i) Stereo Mix

Effects ini digunakan untuk mengatur pencampuran suara antara

chanel kiri dan kanan.

j) Tone

Effects ini digunakan untuk membuat suara synthesizer dengan

melakukan pengaturan pada properti. Effects ini anda dapat membuat

suara seperti gemuruh di dalam air, nada telepon saat sambung,

terputus, sirine dan sebagainya. Apabila anda memasukan Effects ini

kedalam layar audio, maka suara asli di dalam layer audio tersebut

tidak akan terdengar sama sekali. Effects ini juga dapat dimasukan

kedalam layer yang tidak terdapat audio didalamnya seperti layer solid.

11.7 Kategori 3D Channel

Effects dalam kategori 3D Channel ini bekerja pada layer 2D yang

menyimpan informasi 3D. File layer 2D biasanya Image Sequence. Cara

kerja Effects 3D yaitu mendeteksi berbagai informasi tambahan yang tidak

ada sebelumnya seperti: sumbu Z, koordinat tekstur, warna background, dan

sebagainya. Dengan menggunakan Effects ini dapat menyisipkan elemen ke

dalam background, mengaburkan area dan sebagainya.

Effects yang ada dalam kategori ini diantaranya :

3D Channel Extract, Depth Matte, Deoth of Field, EXtractoR, Fog 3D,

ID Matte dan Identifier.
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Gambar 11.5 Tampilan Effects dan Presets 3d Chanel

11.8 Referensi Effects

Effects dalam adobe after effects di kelompokkan berdasarkan kategori.

Namun juga dapat di rubah berdasarkan kategori, folder, dan sesuai abjad

melalui Panel Menu. Effects dalam kategori 3D Channel ini bekerja pada

layer 2D yang menyimpan informasi 3D File layer 2D biasanya Image

Sequence. Cara kerja Effects 3D yaitu mendeteksi berbagai informasi

tambahan yang tidak ada sebelumnya seperti: sumbu Z, koordinat tekstur,

warna background, dan sebagainya. Dengan menggunakan Effects ini dapat

menyisipkan elemen ke dalam background, mengaburkan area dan

sebagainya.
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Dalam latihan kali ini penulis akan memperkenalkan beberapa Effects

yang dimiliki after effect Effects dalam kategori ini diantaranya :

3D Channel Extract, Effects Blur & Sharpen, Effects Channel, Effects

Keying

Effects keying, Effects Distort, EXtractoR, Fog 3D, ID Matte dan

Identifier.

a) Effects Blur & Sharpen

Secara umum, Effects di dalam kategori ini bekerja dengan cara

memperlebar atau mempersempit area piksel. Contohnya, dengan

menambah nilai properti Blirriness pada Effects Gaussian Blur akan

membuat piksel pada gambar menjadi tampak samar.

Gambar 11.6. Tampilan Effects Blur & Sharpen
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o Effects Channel

Berisi sejumlah Effects yang di gunakan untuk berkreasi dengan warna

tertentu yang ada di dalam sebuah gambar seperti mengatur rotasi,

posisi, atau skala pada warna tertentu.

Gambar 11.7 Tampilan Effects Channel Warna

o Effects Distort

Effects di dalam kategori ini umumnya di gunakan untuk

melengkungkan atau mendistorsi layer gambar.

Gambar 11.8 Tampilan Effects Distort



TEKNIK PENYUNTINGAN DIGITAL

131

o Effects Keying

Di dalam Adobe After Effects terdapat sejumlah Effects Keying yang

dikelompokkan di dalam kategori ini. Effects Keying ini digunakan untuk

memberikan transparansi pada warna atau bagian tertentu sehingga dapat

diganti dengan warna atau gambar yang lain.

Gambar 11.9 Tampilan Effects Keying

o Effects Noise & Grain

Setiap gambar atau video digital terdapat noise yang desebabkan oleh

proses recording, encoding atau proses reproduksi dari peralatan yang

digunakan untuk mengolah gambar itu sendiri. Noise tidak selalu buruk,

terkadang malah dibuat dengan sengaja ke dalam sebuah gambar untuk

memperkuat kesan pada gambar itu sendiri seperti: menambahkan grain

ke dalam gambar untuk membuat kesan film tua.
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Gambar 11.10 Tampilan Effects Noise & Grain

o Effects Stylize

Stylize adalah gaya. Dengan menggunakan Effects di dalam kategori

ini. Dapat menciptakan gaya anda sendiri ke dalam gambar.

Gambar 11.11 Tampilan Effects Stylize
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BAB XII

PREVIEW DAN RENDERING

Tujuan Pembelajaran Umum

 Mampu melihat hasil akhir dalam memasukan unsur efek dari adobe

after effect serta export file project sesuai out put yang diinginkan.

Tujuan Pembelajaran Khusus

Pembelajaran pada bab ini bertujuan untuk:

 Mampu melakukan render preview sebagai koreksi final sebelum

export file.

 Mampu melakukan setting export dengan benar sesuai tujuan akhir.

 Mampu memahami fungsi Adobe Media Encoder dalam melakukan

export.

 Melihat hasil render melalui player video.
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12.1 Preview dan Rendering

Rendering merupakan tahap paling akhir dari proses pembuatan after

effect hal ini kita harus mengenal terlebih dahulu arti dari preview. Preview

dilakukan editor untuk mengetahui pergerakan pada animasi berjalan dengan

baik atau masih ada yang perlu ditambahkan dan diedit. Adobe after effect

CC2015 terdapat ram preview yang berfungsi memperingan kerja komputer

saat editor melakukan preview secara Real-time. Selain itu kita juga harus

mengetahui istilah Pre-compse.

Dalam istilah sehari-hari rendering penulis analogikan mencampur

semua elemen bahan, misalny dalam hal memasak agar masakan bisa

bercampur dengan bumbu serta sayur maka kita perlu mencampur kedalam

wajan agar tercipta masakan yang enak. Tentu saja dengan sering berlatih

memasak maka kita akan mendaptkan rasa yang pas dan juga lezat. Sama

halnya dengan rendering merupakan proses untuk mencampur semua elemen

efek dan untuk mengubah file project adobe after effect menjadi video.

Gambar 12.1 Tampilan Video Siap Render
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Dalam sebuah animasi, proses rendering dilakukan frame-by-frame dan

semua tergantung pada laptop atau PC editor. Setelah sebuah composition

di-render, maka program akan mengubah frame yang telah dirender tersebut

menjadi sebuah file yang diinginkan.

Berbagai jenis format disediakan after effect berdasarkan dimana file

output akan diputar. Misalnya editor mengiginkan file video tersebut nantinya

akan digabung dengan video pada project premiere pro maka editor dapat

render dengan preset AVI. Jika editor apabila video yang sudah dibuat agar

bisa di upload dan diputar pada internet maka editor dapat merubah preset

output menjadi format FLASH VIDEO flv.

12.2 Cara Seting Render

a) Klik File.

b) Export.

c) Add To Render Queue.

d) Output Module Seting Format Klik OK.

Gambar 12.2 Tampilan Output Modul Seting
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12.3 Menentukan Output Movie

a) Tampilan pada time line akan berubah menjadi Current Render.

b) Scrool kebawah klik Output Movie To.

c) Tulis file name.

d) Save.

Gambar 12.3 Tampilan Output Movie To

12.4 Render

a) Pada tampilan current render

b) Klik pilihan render

c) Tunggu hingga warna biru terisi penuh

d) Muncul bunyi khusus jika render selesai
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Gambar 12.4 Tampilan Rendering

12.5 Hasil Render

a) Cek video pada data penyimpanan.

b) Play video menggunakan Player.

c) selesai.

Gambar 12.5 Hasil Video
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